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1 Introduction

Welcome To MADRIX RADAR

Manage, configure, and monitor your RDM devices remotely and automatically, and receive regular status updates and

notifications. MADRIX RADAR is the essential tool for intelligent and automatic Remote Device Management [RDM].

Thank you for choosing MADRIX!

How To Use This User Guide

§ Press F1 on your keyboard while working with the application to quickly call up the MADRIX RADAR Help and

Manual.

§ LINKS are displayed in this color. Simply click through and you will be taken to the corresponding part within the

same topic.
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§ »LINKS will take you away from the topic which your are currently reading to another section in this guide or to

an external website.

§ This user guide is written in English.

Topics Of This Chapter

§ »Glossary 

§ »System Requirements

§ »License Model

§ »About

§ »Web Links

1.1 Preamble

This topic includes:

§ Basic Concepts

§ Using MADRIX RADAR Software & Differences Between MADRIX 5 And MADRIX RADAR

Basic Concepts

MADRIX RADAR packs and organizes RDM into an easy-to-use software tool. That means that most of the functionality

is based on the RDM standard and the possibilities it does and does not provide.

RDM stands for Remote Device Management, which already describes it very well. It is about changing the settings,

organizing, monitoring, and working with devices from afar. Lighting fixtures can be RDM devices, but not all RDM

devices are necessarily lighting fixtures. There are many more types of RDM devices.

RDM [ANSI E1.20] is built on the DMX512 standard [DMX512-A – ANSI E1.11]. It only functions on the DMX line.
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In order to be able to use MADRIX RADAR and any of its features, all involved devices on the DMX line need to support

RDM. If devices do not support RDM, RDM cannot be used and devices cannot be managed with RADAR. Do not expect

any lighting fixture [or any other device] to automatically support RDM. It also does not mean that all DMX512 devices

automatically support RDM.

It depends on each device which RDM features are supported [such as sensors, DMX start address, DMX personality,

etc.]. RDM only requires a few details as the minimum that should be reported back upon receiving a request. In this

way, actual RDM support could be severely limited. On the other hand, there are many features a manufacturer could

implement. RADAR relies on the data and settings a device provides via RDM. It can only work with the information it

receives from the device. Such data is only provided by the device upon request.

Again, RDM is built on DMX512. DMX512 itself has its own limitations. Nowadays and especially for large projects, the

Art-Net standard is often used to overcome some of those major limits. That still means that RDM itself only works on

the DMX line. But Art-Net makes it possible to forward it on an Ethernet-based network. RADAR uses RDM over Art-

Net. This data tunnel is referenced as the ArtRdm subcategory within Art-Net.

1] MADRIX RADAR's role in the world of RDM is that it sends commands and data requests to RDM Responders via

ArtRdm [Manager]. Requests are queries sent out to receive back information from RDM devices. Commands are used

to remotely set parameters and settings of RDM devices.

2] The role of MADRIX STELLA, as an example of a DMX controller, is that it transmits commands and requests to

RDM Responders and back [Art-Net Node / RDM Controller]. In this way, STELLA supports ArtRdm as well as DMX

RDM.

3] The third major component is the RDM device itself, which acts on commands and replies to requests with data via

DMX RDM [RDM Responder].

There could be additional RDM devices in this line of communication, such as DMX512 RDM splitters on the DMX line,

which are called in-line devices.

All involved devices [such as software, controller, and device] need to support RDM. Otherwise, it will not work.

MADRIX RADAR does not support any other protocols, only RDM and Art-Net, and more specifically RDM over Art-Net

[so-called ArtRdm].

Learn more »Technical Standards 
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Using MADRIX RADAR Software &

Differences Between MADRIX 5 And MADRIX RADAR

Overview

If you have used MADRIX 5 before, you will have noticed that both software applications 'feel' very differently. That is

because they are. We are trying to explain some of the key differences here.

Live Control

MADRIX 5 is built for live control. Interactions with the software [such as changing a color] should be doable as quickly

as possible [with minimum possible wait time, and without requiring unnecessary confirmations]. It provides the

possibilities to instantly create, manipulate, and design. It was built for Lighting Control. MADRIX 5 is much more

about actively initiating a desired outcome.

Device Management

In comparison, MADRIX RADAR works completely differently. It is made for Device Management. It mainly shows

the current status of your devices. For example, you can manually change many settings with the help of buttons and

usually a small LCD display on your lighting fixture itself, such as the DMX start address, right? Those are the settings

you can possibly change with RADAR with remote access. You can perform any configuration conveniently from your

computer; instead of requiring direct access to the devices themselves in the truss, in the ceiling, or on the facade.

And the software always informs you how these settings are currently set. RADAR is about changing configurations,

but much more about passively monitoring the current situation.
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Database

The user interface of RADAR shows the current status of your devices as reported back by those RDM devices, with

information that has been received [there could be inquiries and responses that were lost], with data that has been

stored in the database. Working with a large amount of information in a database, sending out requests, and receiving

back responses simply takes time. That is why RADAR is not designed for extremely fast interactions. All those settings

that can be managed usually do not require immediate changes anyways. It is much more important to receive

information, and to reliably and consistently show the devices' status in a timely manner of seconds, minutes, hours,

and days; not milliseconds. It is a much more asynchronous workflow.

Using a database also means that there is no setup file to be saved or similar. RDM devices and their information are

all stored in the database. And it depends on which database management system you have selected in the options,

how the data is stored. For example, the default setting is SQLite In Main Memory, which means that the data is lost

once you close the software. In contrast, SQLite File and PostgreSQL Server are options for permanent storage.

Learn more »Database 

Visual Feedback For Edits

RADAR reports back the current status of any changes you made to an RDM device via the GUI with the help of colored

labels. It is not showing live data per se, but uses yellow to indicate that the request has been sent to the RDM device.

It uses green in case the device reported back that settings have been changed successfully and red if the changes

could not be set or if the request timed out. That means you might need to wait shortly before your changes are

applied. Also, make sure to confirm any changes by clicking away from the selection or simply use the Enter key on the

keyboard.

Features Of RDM Devices

There are many types of RDM devices. Devices report back which features and settings they offer. If a device does not

support identification, you will not able to highlight it with RADAR. Such visual identification is a mode that the device

needs to offer as one of its settings. Highlight Device in MADRIX 5, on the other hand, is a software feature that simply

sends DMX value 255 on all color channels [full-on white]. Because MADRIX 5 is about using lighting fixtures to control

their color and intensity output, it is something the software can offer. RADAR cannot offer software features for RDM



[Part 1] Introduction

//10www.madrix.com

MADRIX RADAR 1.2. Help And Manual

devices they are not offering themselves, since the manufacturer needs to have the features implemented on the

devices' hardware level and firmware level.

That means that different views of RADAR [Parameters, Sensors, Status Messages, Slots, Presets] might

not contain any information or data because the device does not support it.

DMX Universe

RDM does not know about the DMX universe. RDM works on the DMX line. And a single line does not know about the

DMX universe either. That is why you may only set up the DMX start address on a lighting fixture, for example. Only

when using more DMX lines, the concept of several lines evolved into DMX universes, which then became a setting of

the DMX controller. That is why you cannot change the DMX universe within RADAR. With MADRIX nodes however,

such as MADRIX STELLA, you can call up the web configuration to change it there [Interfaces view > Right

Mouse Click on an interface > Open Interface Configuration Via HTTP...].

Lists

RADAR possibly needs to manage a lot of devices and therefore a lot of data. The main method to organize and

present this information on the user interface is lists. You can customize how these lists look like, by changing which

column is used for sorting, plus changing the order from ascending to descending or vice versa. You can also decide

which columns to show or hide. And you can use the Search bar as filter to quickly find what you are looking for.

List Of Devices

The main view of RADAR is the list of Devices. In order to add your devices to the list, RADAR needs to send out a

request [menu Devices > Discover Devices]. Once they show up in the list, this also means that they first had been

added to the database. The user interface represents these data entries.

If you want to remove a device, you will have to do it manually. There is value in knowing when devices have not

been found or do not respond anymore. When using RADAR, you surely want to know if that is the case, because this

often means that something is wrong. Removing items from the list automatically would remove them without your
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knowledge, and this important information would be lost. But knowing about such issues is why RADAR is used in the

first place.

If you have physically removed devices from your project, you can remove them from RADAR and its database as well

[Devices view > Right Mouse Click on a device > Delete].

Devices

RADAR uses the connection path to distinguish between different devices [Network – Node – Universe – ID]. For

example, if you have connected the same fixture to two different RDM controllers or to the same controller with two

different universe assignments and let RADAR search for the RDM device in each case, the same device shows up

twice in the list of Devices. If only the unique ID would be used, they would only show up once since the device's ID is

already in the list. But as explained above, this would not suffice, since devices are not and should not be removed

automatically [or removed and re-added in this case].

Patch And Patch Editor

The Patch Editor of MADRIX 5 and the Patch Editor of RADAR also work very differently. The Patch in the Patch Editor

of MADRIX RADAR only represents the logical order of DMX addresses. It does not show the physical layout of the

lighting setup, for example. This is an information which RDM devices do not and simply cannot provide. The Patch

Editor in MADRIX 5, in contrast, defines how the fixtures should be arranged or it represents how fixtures are already

physically arranged. Here is a tip: Make sure to select the correct universe and correct network device in the Patch

Editor of RADAR first or you may be confronted with many warning messages that might only apply to the current view

options, but the settings are correct nevertheless.

Log

The log itself is much more prominent compared to MADRIX 5. Messages and errors in the log might only be for your

information. It could show what a device might not support, but creates an error since it may be required by the RDM

standard as default information to provide. Any information provided in the log needs your careful inspection and
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reasoning to determine how relevant it is for you. The Events view might offer much more actionable insights.

Learn more »Events

1.2 Glossary

Art-Net

Art-Net is a communication protocol that allows to distribute DMX512 data over Ethernet network. Often, so-called Art-

Net nodes then act as Ethernet-to-DMX512 converters and hardware interfaces. MADRIX STELLA is such an Art-Net

node, for example.

DMX512

DMX512, often abridged to DMX, is an unidirectional communication protocol used mainly to control lighting luminaires,

which use 5-pin XLR connectors as defined by the standard. 3-pin connectors are also common, but not defined as

standard connectors.

When working with DMX-based products, each fixture needs a specific attribution via its DMX channel and its DMX

universe. With the specific DMX channel and DMX universe, the LED product can be identified directly for a correct

communication with the fixture.

DMX Channel

A total of 512 DMX channels is available per DMX universe. Each DMX channel is an individual control channel. Valid

values range from 0 to 255, with a total of 256 values.

DMX Universe

A DMX universe contains 512 DMX channels and represents 1 DMX line. To control more than 512 DMX channels,

more than 1 DMX universes need to be used. For example, 2 DMX universes represent 1024 DMX channels.

For example, you can control 170 RGB fixtures per DMX universe. That means, calculating 170 fixtures x 3 channels

results in 510 DMX channels. Therefore, channel 511 and 512 will be left empty.

And if your are using more then 170 fixtures, those DMX channels will be assigned to a new DMX universe [e.g., DMX

universe 2].
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IP Address

Is an identifier for devices that enables network communication. It is hosted in the Internet protocol on Layer 3 of the

OSI model. When using network protocols, it needs to be set up for each individual sender or recipient in the network.

Art-Net and MADRIX RADAR only use TCP/IPv4.

MAC Address

Is a unique, technical identifier for devices in a network and assigned by the manufacturer. It is used in Layer 2 of the

OSI model.

RDM [Remote Device Management]

In its base variant defined as 'ANSI E1.20 - 2010, Entertainment Technology - RDM - Remote Device Management Over

DMX512 Networks'. A two-way means of communicating with DMX512 devices that allows not only to send

instructions, but to receive data back from the device.

Subnet Mask

Is a technical grouping mechanism for network devices that relate to the IP address. When using the Internet protocol,

it needs to be set up for each sender or recipient in the network for correct data routing.

1.3 System Requirements

This topic includes:

§ Supported Operating Systems

§ Minimum System Requirements

§ Recommended Computer Specifications

§ General Requirements

§ Optional Requirements

§ Separate Computers

§ Contact
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Supported Operating Systems

§ Microsoft Windows 10

§ 64 bit only.

§ Please keep the system, drivers, and updates up to date.

Minimum System Requirements

§ 2.0 GHz dual-core CPU

§ 2 GB RAM

§ 1 GB free harddisk space

§ 1280 x 768 screen resolution

§ Network card

§ USB 2.0

Recommended Computer Specifications

§ At least a 2.0 GHz dual-core CPU or better

§ 4 GB RAM or higher

§ 2 TB SSD or higher

§ 1920 x 1080 screen resolution or higher

§ Network card

§ USB 2.0
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General Requirements

§ For the general functionality, the following is required:

- Devices that are compatible with RDM.

- Having those devices connected over Art-Net to interfaces/nodes that are compatible with RDM [ArtRdm].

- Learn more »Technical Standards

Optional Requirements

Depending on your use-cases, you may need to meet the following requirements:

§ For automatic event notifications [that is, e-mail messages]:

- An active Internet connection.

- This connection should be separated from the network card that is used for the RDM communication.

§ In case of using MADRIX RADAR with MADRIX RDM nodes:

- MADRIX STELLA with at least minimum firmware version 2.3.7261. [It is recommended to always use the latest

firmware version.]

§ In case of using MADRIX RADAR with RDM nodes of third-party manufacturers:

- A MADRIX KEY with a valid MADRIX RADAR fusion license [fusion small, fusion medium, fusion large].

- Learn more

§ For the Big Data features:

- A MADRIX KEY with a valid MADRIX RADAR big data license.

- Installation of the PostgreSQL Database management system; in at least version 11.

- Having created a suitable database within PSQL and setting up the corresponding settings in MADRIX RADAR.

- Learn more

§ When using MADRIX RADAR as well as MADRIX 5:

- It is recommended to run both applications on separate computer systems. Learn more below
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Separate Computers

When using MADRIX RADAR as well as MADRIX 5, it is recommended to run both applications on separate computer

systems due to the following reasons:

§ Performance – CPU

- MADRIX 5 mainly requires CPU performance, especially when controlling large matrices or 3D projects. 

- Using two separate systems ensures that MADRIX 5 can utilize the power of the main processor as required.

- The more CPU power is available, the better. 

- When using two computers, MADRIX RADAR does not cause additional CPU load, which frees up resources for

MADRIX 5.

§ Performance – Physical Memory [RAM]

- MADRIX RADAR mainly requires RAM, especially when managing a large number of RDM devices. 

- Using two separate systems ensures that MADRIX RADAR has as much access to memory as required.

- The higher the amount of memory that is available, the better.

- When using two computers, MADRIX 5 does not require additional memory, which frees up resources for

MADRIX RADAR.

§ Performance – Network Card

- MADRIX RADAR uses the network card and its available bandwidth and performance since it communicates

over Ethernet network [RDM over Art-Net, i.e. ArtRdm]. The more devices MADRIX RADAR manages, the higher

the requirements.

- MADRIX 5 would also use the Ethernet-based Art-Net control protocol in this case, which would also require the

resources of the network card. The higher the pixel resolution and number of LED fixtures, the higher the

requirements.

- In order to achieve the highest performance as well as the best reliability and stability of the network, two

computers with separate network cards are recommended.

- [Using two network cards in one computer adds load to the internal bus system and large projects may already

require usage of several network cards for MADRIX 5.]

§ Network Communication – Shared Data Socket

- Regarding communication over Art-Net and thus an Ethernet-based communication, the Windows operating

only allows the first network application to send and receive network data. All other applications can only send

data.

- That means on a single computer system, MADRIX RADAR needs to be launched first. Otherwise, no RDM data

can be received.

- On the other hand, while MADRIX 5 would be started afterwards as second application, it would not be able to

find Art-Net nodes automatically, since it is able to send the polling packet, but would not be able to receive the
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reply. Nodes need to be added manually in this case.

- For your own convenience and in order to prevent technical issues, two separate computers are recommended.

Contact

Please contact us if you require more information. »Imprint And Copyright

1.4 License Model

This topic includes:

§ Introduction

§ License Model

§ Demo Mode

§ MADRIX RDM Nodes

§ Third-Party RDM Nodes & MADRIX RADAR fusion License

§ MADRIX RADAR big data License

§ MADRIX KEY

§ License Check

§ Important Information

§ Interruption-Free Operation

§ End-Of-Life

Introduction

MADRIX RADAR is a commercial software product that requires a valid license in order to be able to fully use it.

Please learn more below.
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License Model

MADRIX RADAR is an independent software that allows you to choose compatible RDM nodes. 

You gain the enormous advantage with MADRIX RDM nodes of running a fully integrated system. Our MADRIX

hardware processes RDM data packages in a way that does not result in interference with DMX data packages during

full and live operation, which could lead to visual flickering or other signal interruptions.  MADRIX interfaces manage

these data streams highly efficiently and intelligently.

MADRIX 
RDM Nodes

Third-Party RDM Nodes
& MADRIX RADAR License

Software
License No additional software

license is required.
Demo

MADRIX
RADAR

fusion small

MADRIX
RADAR
fusion

medium

MADRIX
RADAR

fusion large

RDM
Devices/S

ub-
Devices

All connected devices are
automatically unlocked for

free.

2 64 512 4,096

Managem
ent

Yes Yes Yes Yes Yes

Configura
tion

Yes Yes Yes Yes Yes

Monitorin
g

Yes Yes Yes Yes Yes

§ Learn more about »MADRIX RADAR fusion licenses 

§ In addition, you can opt for the separate »MADRIX RADAR big data license
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Demo Mode

When using third-party RDM nodes, MADRIX RADAR offers a demo mode. As such, you can download the latest

MADRIX RADAR Software to test for free at »www.madrix.com

What are the features of the Demo Mode?

§ You can test MADRIX RADAR for free.

§ The software is functional [within the demo limitations and license limitations].

§ Demo mode is useful for evaluation and tests.

§ Files and settings are fully compatible with the full version [it is the same software].

§ If no valid license is provided/connected, MADRIX RADAR runs in demo mode.

What are the limitations of the Demo Mode?

§ Only 2 RDM devices/sub-devices are fully unlocked to send RDM requests to or receive from.

§ Any other devices connected to third-party RDM nodes are locked and cannot not be managed, configured, or

monitored.

§ Big Data features are not available.

§ If using MADRIX RDM nodes or providing a MADRIX RADAR fusion license, these 2 devices will not be unlocked

additionally.

MADRIX RDM Nodes

§ All RDM devices and RDM sub-devices that are connected through MADRIX RDM nodes are automatically

unlocked and licensed in the software.

§ Learn more »MADRIX Hardware 

§ Learn more »MADRIX STELLA 

http://www.madrix.com
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Third-Party RDM Nodes & MADRIX RADAR fusion License

MADRIX RADAR fusion Licenses

§ Require a valid, metallic MADRIX KEY.

§ Online activation is initially required one time. Learn more »Online License Activation

§ It is possible to have a MADRIX RADAR fusion license and a MADRIX RADAR big data license on a single MADRIX

KEY.

The MADRIX RADAR fusion licenses are available as:

§ MADRIX RADAR fusion small

[Unlocks up to 64 RDM devices/sub-devices in the software.]

§ MADRIX RADAR fusion medium

[Unlocks up to 512 RDM devices/sub-devices in the software.]
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§ MADRIX RADAR fusion large

[Unlocks up to 4,096 RDM devices/sub-devices in the software.]

MADRIX RADAR License Upgrades

§ Upgrade your MADRIX RADAR fusion license on your MADRIX KEY to a higher license in order to unlock more

RDM devices/sub-devices.

§ Online activation is initially required one time. Learn more »Online License Activation

§ Require a valid and metallic MADRIX KEY with a MADRIX RADAR fusion license.

MADRIX RADAR big data License

MADRIX RADAR big data License

§ Require a valid, metallic MADRIX KEY.

§ Online activation is initially required one time. Learn more »Online License Activation

§ It is possible to have a MADRIX RADAR fusion license and a MADRIX RADAR big data license on a single MADRIX

KEY.

This license is available as:

§ MADRIX RADAR big data

[Is available as separate license, which can be renewed. Unlocks the Big Data features for 1 year for MADRIX

RADAR.]
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MADRIX KEY

MADRIX KEY

The MADRIX KEY is a USB dongle.

It needs to be connected to your computer. Only then, it activates the license it provides for software. 

You will require and receive a MADRIX KEY, when purchasing a MADRIX RADAR fusion License [or MADRIX RADAR big

data license].

Online License Activation

Please activate your MADRIX KEY first, when using the MADRIX RADAR Software for the first time

[or when having acquired a MADRIX RADAR License or MADRIX RADAR License Upgrade].

Please follow the steps described below:

1] Make sure you are online. An active internet connection is required for the activation.

2] Download the latest MADRIX RADAR Software from www.madrix.com

3] Install the MADRIX RADAR Software and then connect the MADRIX KEY to your computer.
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4] Start MADRIX RADAR now and go to the menu Help > MADRIX KEY > Activate MADRIX KEY...

5] Enter your ticket number and follow the on-screen instructions.

License Check

You can check which MADRIX RADAR licenses your MADRIX KEY provides.

§ Start the MADRIX RADAR Software.

§ Go to the menu Help > About...

§ A new window will open.
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§ MADRIX RADAR fusion License

- MADRIX KEY Serial Number - Shows the serial number of the MADRIX KEY that holds the MADRIX

RADAR fusion license. 

[Shows Not Available if no MADRIX KEY has been recognized, can be found, or is available.]

- Type - Shows which kind of fusion license is provided [small (64 Devices), medium (512 Devices),

large (4096 Devices)].

[Shows Not Available if no MADRIX RADAR fusion license has been recognized, can be found, or is available.]

- Expiration Date - Shows the date and time in the future until the license is valid. If this deadline is
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reached, the license will no longer be valid. 

[Shows Lifetime if the license does not expire. Shows Not Available if no MADRIX RADAR fusion license has

been recognized, can be found, or is available.]

§ MADRIX RADAR big data License

- MADRIX KEY Serial Number - Shows the serial number of the MADRIX KEY that holds the MADRIX

RADAR big data license. 

[Shows Not Available if no MADRIX KEY has been recognized, can be found, or is available.]

- Expiration Date - Shows the date and time in the future until the license is valid. If this deadline is

reached, the license will no longer be valid. 

[Shows Lifetime if the license does not expire. Shows Not Available if no MADRIX RADAR big data license

has been recognized, can be found, or is available.]

§ Please note: It is possible that a single MADRIX KEY holds both licenses, a MADRIX RADAR fusion license as

well as a MADRIX RADAR big data license. If that is the case, the same MADRIX KEY serial number will be

shown.

Important Information

§ The MADRIX KEY is an extremely important item when having bought one or more software

licenses. Do not lose it!

§ A MADRIX KEY is not bound to one computer and can be used with other computers. But it only

provides the corresponding license on the computer it is connected to.

§ Do not connect the MADRIX KEY to your computer before installing the MADRIX RADAR Software.

§ If you connect several MADRIX KEYs with different MADRIX RADAR fusion licenses, the first license

that is recognized will be used.
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Interruption-Free Operation

To ensure interruption-free operation of the software and devices, please make sure to check the power saving

settings of Windows.

Learn more »PC Power Management

End-Of-Life

This electrical device and its accessories need to be disposed of properly. Do not throw the device into normal trash or

household waste. Please recycle packaging material whenever possible.

1.5 About

This topic includes:

§ Introduction

§ Overview

Introduction

The About window provides a quick overview over software details, licensing information, and legal information.

§ Go to the menu Help > About...
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Overview
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Software

Version Shows which software version you are currently running and using. It also shows the

used software architecture: MADRIX RADAR is 64-bit only.

Build Shows when the current software version was created.

ESTA Manufacturer

List Version

Shows which version of the provided ESTA Manufacturer List the software is currently

using.

Legal Copyright © inoage GmbH. See »Imprint And Copyright

End-User License

Agreement

Opens this user guide, which includes the End-User License Agreement. See »End-

User License Agreement [EULA]

MADRIX RADAR fusion License

MADRIX KEY Serial

Number

Shows the serial number of the MADRIX KEY that holds the MADRIX RADAR fusion

license. 

Shows Not Available if no MADRIX KEY has been recognized, can be found, or is

available.

Type Shows which kind of fusion license is provided [small (64 Devices), medium

(512 Devices), large (4096 Devices)].

Shows Not Available if no MADRIX RADAR fusion license has been recognized, can

be found, or is available.

Expiration Date Shows the date and time in the future until the license is valid. If this deadline is

reached, the license will no longer be valid.

Shows Lifetime if the license does not expire.
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Shows Not Available if no MADRIX RADAR fusion license has been recognized, can

be found, or is available.

MADRIX RADAR big data License

MADRIX KEY Serial

Number

Shows the serial number of the MADRIX KEY that holds the MADRIX RADAR big data

license. 

Shows Not Available if no MADRIX KEY has been recognized, can be found, or is

available.

Expiration Date Shows the date and time in the future until the license is valid. If this deadline is

reached, the license will no longer be valid.

Shows Lifetime if the license does not expire.

Shows Not Available if no MADRIX RADAR big data license has been recognized,

can be found, or is available.

Third Parties

Qt About Qt - Shows more information about the Qt development framework.

View License - Shows the license under which Qt is used.

Sourcetree Is a Git client program used for development with thanks. Powered by Atlassian. 
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Miscellaneous

Left Mouse Click + Hold + Select / Left Mouse Double-

Click / Left Mouse Triple-Click - Allows you to select text. 

Right Mouse Click > Copy - Allows you to copy text in order to

paste the information into an e-mail, for example.

Check For Software Updates Checks online if a software update or new ESTA Manufacturer List is

available for downloading. This requires an active internet connection.

Close Closes the About window.

1.6 Web Links

This topic includes:

§ Overview

Overview

You can find a selection of useful internet links here:

§ MADRIX Website

»www.madrix.com

§ Downloads

»www.madrix.com/support/download

§ User Guides [Online And Downloadable PDF]

»help.madrix.com

§ Online Forum

»www.madrix.com/support/forum

https://www.madrix.com/
https://www.madrix.com/support/download
http://help.madrix.com/
https://www.madrix.com/support/forum


[Part 1] Introduction

//31www.madrix.com

MADRIX RADAR 1.2. Help And Manual

§ Software Release Notes

»www.madrix.com/products/software/releases

https://www.madrix.com/products/software/releases
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2 Getting Started

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Learn in this chapter how to

§ install and start the MADRIX RADAR Software.

§ create a stable operation environment.

Topics Of This Chapter

§ »Installation Process 

§ »Starting The Software 

§ »PC Power Management

§ »Tips [Microsoft Windows / Networks / USB]

2.1 Installation Process

This topic includes:

§ Important Notes

§ Using The MADRIX USB Flash Drive

§ Downloading The Software Online

§ Setup Process

§ Uninstallation

§ Software Update
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Important Information 

§ Please note regarding Purchased Products, Demo Mode, and Updates:

- The MADRIX RADAR Software can be downloaded from »www.madrix.com. Software updates will be also

released online. 

- If no license is unlocked, the software will run in demo mode. Learn more »License System

§ It is highly recommended to always use the latest software update.

Using The MADRIX USB Flash Drive

When using a MADRIX USB flash drive for the installation process, please connect the drive to a free USB port of your

operational computer. The MADRIX RADAR setup will start automatically using an Auto Installer. Please wait until the

setup has fully loaded. Then, proceed with the Setup Process as described below. When the Auto Installer does not

launch, please navigate to the drive in Windows and manually start the setup process by performing a double-click on

MADRIX_RADAR_Install.exe

Downloading The Software Online

§ Download MADRIX_RADAR_Install.exe from »www.madrix.com 

§ After downloading the installer, please double-click with your mouse on this file in order to start the setup

process.

§  Please wait while the Auto Installer is loading the setup. 

§ Afterwards, proceed with the Setup Process as described below.

https://www.madrix.com
https://www.madrix.com/
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Setup Process

Please make sure to:

1] Log into Windows as administrator [Admin].

2] Let the computer process the setup. This may take some minutes depending on the speed of your computer.

3] Allow Windows to install all drivers. Windows may ask for your permission to install drivers and expects your

confirmation. Please search for such pop-up windows; they might have opened in the background and might be

covered by other windows.

4] If available, connect your MADRIX KEY before you start a software update [not during the first installation]. In

this way, the MADRIX KEY firmware can automatically be updated if required.

Please install the MADRIX RADAR Software before you connect a MADRIX KEY.

Step 1]

§ Please select your preferred language and confirm

with OK

§ You can always quit the setup by clicking Cancel
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Step 2]

§ Click Next to start the installation.

§ Click Back in order to return to a previous step

during the setup process.

Step 3]

§ The License Agreement will appear. It outlines

the terms you are agreeing to by installing the

software. You must accept these terms in order to

continue.

§ Please click I Agree

 Step 4]

§ This window allows you to select which components

and which drivers you want to install. A description is

given for each item. 

§ MADRIX RADAR - Is a required component. It

refers to the MADRIX RADAR Software.

§ Desktop Shortcut - Select if you wish to create a

shortcut to the software on your Windows desktop.

By default, the component is selected.
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§ Quick Launch Shortcut - Select if you wish to

create a shortcut to the software in your Windows

taskbar. By default, the component is not selected.

§ MADRIX KEY Driver - Is a required component.

Installs the MADRIX KEY driver.

§ MADRIX KEY Firmware Update - Select if you

wish to install the latest firmware on connected USB

protection dongles. Please disconnect any unwanted

dongles if you select the option.

§ Next - Click Next after choosing the components in

order to continue.

Step 5]

§ Choose an installation directory on your hard drive

where the software will be installed. A default

Destination Folder will automatically be provided

by the setup. 

§ Browse... - Click to change the folder.

§ Install - Click to start the installation process.
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Step 6]

§ The installation process may take a few minutes.

§ Installation Complete - Click Next when this

message shown.

Step 7]

§ Run MADRIX RADAR - Deselect if you do not

wish to start the software now. 

§ Finish - Click to quit the setup.

§ When starting MADRIX RADAR for the first time,

please make sure to learn more about working with

Windows.
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Learn more »Tips [Microsoft Windows /

Networks / USB]

Uninstallation

Step 1]

§ Please select your preferred language and confirm

with OK

§ You can always quit the uninstaller by choosing

Cancel

§ Click Back in order to return to a previous step

during the process.

Step 1]

§ Click Next to start the uninstallation.
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Step 2]

§ This window allows you to select which components

and which drivers you want to uninstall. A description

is given for each item.

§ MADRIX RADAR - Is a required component. It

refers to the MADRIX RADAR Software.

§ Log Files - Select if you wish to remove all files

saved for logging. By default, the component is

selected.

§ Documents - Select if you wish to remove the

Documents folder specific to this software from the

My Documents directory; except log files. By default,

the component is not selected.

§ MADRIX KEY Driver - Select if you wish to

uninstall the drivers of the MADRIX KEY. By default,

the component is not selected.

[Only remove it if no other software, such as

MADRIX 5, requires the driver. If you have

such software installed and are using it, do not

remove the driver.]

§ Uninstall - Click Uninstall after choosing the

components in order to continue.
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Step 3]

§ The uninstallation process may take a short while.

§ Uninstallation Complete - Click Close when

this message shown.

Software Update

Checking For New Software Versions

It is always recommended to run the latest software version. MADRIX RADAR automatically searches for updates at

startup.

§ By default, the option is enabled. To change it, select the menu Preferences > Options... > Startup >

Check For Software Updates

§ Choose Skip This Version if you would like to skip a particular version.
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Installing New Software Versions

When a new software version has been released, please update your current MADRIX RADAR installation to the

newest version.

§ Check and download the latest MADRIX RADAR Software as described above.

§ You can also directly download it from »www.madrix.com 

§ It is not required to deinstall MADRIX RADAR before you install a new software version.

§ Instead, follow the process described under Downloading The Software Online 

§ The installer will ask you if you would like to update your current MADRIX RADAR Software installation. Confirm

with Yes

https://www.madrix.com/
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2.2 Starting The Software

This topic includes:

§ Introduction

§ Desktop Shortcut

§ Windows Start Menu

Introduction

You can start MADRIX RADAR in different ways. Among those, the Windows Start Menu is the standard way to launch

applications under the Windows operating system.

Desktop Shortcut

§ Left Mouse Double-Click - Perform a double-click with your left mouse button on the desktop shortcut in

order to start the MADRIX RADAR Software.

- It is required that the shortcut has been manually placed on the Desktop or was automatically installed during

the »Installation Process
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Windows Start Menu

§ In Windows, go to Start > MADRIX RADAR > MADRIX RADAR

- The MADRIX RADAR Software will start.

In addition, the Start Menu contains the following main items:

§ Help MADRIX RADAR

§ MADRIX RADAR Quick Support

2.3 PC Power Management

This topic includes:

§ Why Is Power Management Important?

§ Usage

§ Activate High Performance

§ How To Change USB Power Settings

Why Is Power Management Important?

We strongly recommend to deactivate all power saving options in Microsoft Windows in order to

ensure an interruption-free operation of MADRIX RADAR. Otherwise, normal operation is likely to be

interrupted.

Microsoft Windows operating systems offer a wide variety of power management options. In most cases, laptops,

notebooks, and netbooks benefit from a longer battery life if a good power management is in use. But certain

problems might occur because of computer power savings nevertheless:

§ After a while your MADRIX KEY cannot be identified by the software anymore, for example.
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§ MADRIX RADAR cannot collect data or information from RDM devices, thus it cannot properly function, when the

computer is in standby mode.

Usage

Make sure to set up power-saving settings especially if you are using:

§ A MADRIX KEY [USB dongle].

§ A notebook/laptop to run MADRIX RADAR.

Additionally:

§ Make sure to change the USB power settings.

§ Especially for notebooks, we recommend to activate the High performance power plan. 

Activate High Performance 

This setting will make sure that your notebook or laptop will have all its potential performance available for MADRIX

RADAR.

§ In Windows 10, select Start > Windows System > Control Panel > Power Options, and change the

power plan to High performance

[You might need to click on Show additional plans].
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How To Change USB Power Settings

§ In Windows 10, select Start > Windows System > Control Panel > Power Options > Change

plan settings
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§ Click Change advanced power settings
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§ Especially the USB settings are important. Disable the suspend settings! 

§ Change any other settings that might interrupt the operation as required.

2.4 Tips [Microsoft Windows / Networks / USB]

This topic includes:

§ USB

§ Working With TCP/IP Networks

§ Changing The Priority Of Network Adapters

§ Operating System Security

§ Up-To-Date Drivers

§ Monitoring Computer Performance
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USB

Among others, USB is an important way to work with MADRIX RADAR, MADRIX KEYs, etc. In order to ensure a stable

work environment, we highly recommend setting up corresponding USB settings in Windows. 

Learn more »PC Power Management

Working With TCP/IP Networks

Configuration Of Network Settings

When working with network-based products and MADRIX RADAR [that is, Art-Net], you will have to set up the IP

address of your network card in Windows. Learn how to set it up here.

§ In Windows 10, go to Start > Windows System > Control Panel > Network and Sharing Center

> Change adapter settings > Local Area Connection > Properties > Internet Protocol

Version 4 (TCP/IPv4) > Properties
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Set up the following settings:

§ Enable Use the following IP address:

§ IP address - Sets the IP address for this computer and this network card. 

- If you have several network cars in your computer, you can set up an individual address for each network

card. 

- An IP address has 4 parts. Enter the complete address as explained in the specific chapter of this user guide

[e.g., 10.0.0.1]. 

- You only have to enter the numbers.

§ Subnet mask - Sets up the Subnet mask for this computer. 

- This is an important part of the network settings, just as the IP address. 

- A Subnet mask has 4 parts. Enter the complete address as explained in the specific chapter of this user guide

[e.g., 255.0.0.0]. 

- You only have to enter the numbers.

§ OK - Click to save your settings. 

- [Make also sure to close the Local Area Connection Settings with OK and close the Local Area

Connection Status window with Close.]

§ Restart the MADRIX RADAR Software if you have changed any network settings!

Learn more below.
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Using Several Devices In A Network

Usually, you will use at least 2 devices in a network [for example, 1 MADRIX RADAR PC and 1 Art-Net node]. As

explained above, you will need to configure various network settings not only for your MADRIX PC but also for the

other devices. 

To be able to communicate with each other, all devices have to be in 'the same network'. That means:

§ All devices need to be physically connected with each other [through network equipment, such as hubs or switch

and/or network cables]

§ All devices need to have compatible network settings

Using several devices in a network does not mean that all should have the same IP address. That will not work! 

Instead, follow these rules:

§ Set up all devices within the same IP address range, but never with the same IP address 

[for example, MADRIX PC: 10.204.226.101 and Art-Net node: 10.204.226.102]

§ Set up all devices with the same Subnet mask e.g., 255.0.0.0]

§ If recommended, set up all devices with the same Default gateway [e.g., 10.0.0.1]

Changing The Priority Of Network Adapters

You can change the order in which Windows and MADRIX RADAR accesses your network adapters. By changing the

order, you can specify which network adapter [network card] is used first and as the main connection. 

§ 1] 

In Windows 10, go to Start > Windows System > Control Panel > Network and Sharing Center

> Change adapter settings 
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§ 2] Press Alt on your keyboard.

- A menu appears at the top, which is otherwise hidden.

§ 3] Go to Advanced > Advanced Settings...

- A new window opens.
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§ 4] Select your preferred network connection[s] in the list of Connections:

§ 5] Change the order by clicking on the green up and down arrow buttons on the right hand side.

- The connection which is listed on top, is the first and prioritized adapter.

§ 6] Click OK to confirm.

§ 7] Restart your computer.

Operating System Security

It is recommended

§ to keep Windows up-to-date by installing security updates using Windows Update

§ to use a virus detection software when working with files from external sources.
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Up-To-Date Drivers

Please always keep all component drivers up to date by installing the latest available driver. Among others, this may

include drivers for:

§ Processor

§ Graphics Card

§ USB

Monitoring Computer Performance

Windows allows you to monitor the overall performance of your computer. 

§ Press Ctrl + Alt + Del and choose Start Task Manager

[German shortcut: Strg + Alt + Entf]

§ A new window opens [Task Manager].

§ Go to Performance
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§ You can now monitor the CPU Usage as well as the Memory usage. 



3//PART 
Technical Standards



[Part 3] Technical Standards

//60www.madrix.com

MADRIX RADAR 1.2. Help And Manual

3 Technical Standards

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Learn in this chapter more about the technical standards that MADRIX RADAR is using.

Topics Of This Chapter

§ »RDM [Remote Device Management] 

§ »Art-Net [DMX Over Ethernet]

3.1 RDM [Remote Device Management]

This topic includes:

§ Introduction

§ Overview

Introduction

Remote Device Management is a technical standard that enables the base features of MADRIX RADAR thanks to the bi-

directional communication it defines between controllers, hardware interfaces, and devices. MADRIX RADAR uses RDM

over Art-Net. This data tunnel is referenced as the ArtRdm subcategory within Art-Net.
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Overview

§ MADRIX RADAR [software version 1.2.] supports:

- ANSI E1.20 – 2010

- ANSI E1.37-1 – 2012

§ The standard is defined as ANSI E1.20 - 2010, Entertainment Technology - RDM - Remote Device Management

Over DMX512 Networks.

§ The standard is defined as ANSI E1.37-1-2012, Additional Message Sets for ANSI E1.20 (RDM) – Part 1, Dimmer

Message Sets.

§ It has been published by PLASA North America.

§ It has been approved as an American National Standard by the ANSI Board of Standards.

3.2 Art-Net [DMX Over Ethernet]

This topic includes:

§ Introduction

§ Overview
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Introduction

Art-Net is a communication protocol that allows to distribute DMX512 data over TCP/IP networks [DMX over Ethernet].

Overview

§ MADRIX RADAR [software version 1.2.] supports:

- Art-Net I

- Art-Net II

- Art-Net 3

- Art-Net 4

§ Art-Net has been invented by Artistic Licence and has been published into the public domain.

§ MADRIX RADAR supports specific Art-Net functionality in order to communicate with hardware interfaces [such

as, ArtPoll Reply].

- ArtPoll and ArtPoll Reply are protocol-specific mechanisms to establish a connection between sender and

receiver and exchange interface information.

- MADRIX RADAR, among other packets, uses the ArtRdm packet for RDM over Art-Net.
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4 User Interface [GUI]

This topic includes:

§ Introduction

§ Overview

§ Topics Of This Chapter

Introduction

The user interface is what you see of the software.

You will immediately see it when starting MADRIX RADAR for the first time. This graphical user interface [abbr.: GUI]

provides visual feedback, controls, and information for you.
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Overview

Topics Of This Chapter

§ »Menu 

This topic introduces the menu bar of the software found at the top of the screen.

§ »Toolbar

The optional toolbar provides quick access to common actions.

§ »Customization

MADRIX RADAR provides ways on how to set up the software's user interface according to individual

preferences.

§ »Tooltips

Additional information is readily available if wanted.
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4.1 Menu

This topic includes:

§ Introduction

§ Extra Information Displayed

§ File Menu

§ View Menu

§ Preferences Menu

§ Devices Menu

§ Help Menu

Introduction

The main menu of this software is located at the top of the MADRIX RADAR window.

Extra Information Displayed

Ctrl + N - This represents a keyboard shortcut that will perform the action directly rather than using the menu.

... - Indicates that a new window will open on top of the main MADRIX RADAR window.

> - Indicates that this entry has sub-entries.
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File Menu

 

§ Clear Database - Removes all devices [from the main list] and starts a completely new session. 

Attention: This also deletes the entire content of the database of collected or recorded device data. All of its

entries and contents will thus be erased.

§ Create Snapshot... - Creates a snapshot of all devices and their current settings. Learn more »Snapshots 

§ Restore From Snapshot - Loads a snapshot in order to restore the settings of all devices to this previous

point in time. Learn more »Snapshots 

§ Quit - Closes the software.

View Menu

Refers to how the user interface looks.
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§ Theme > Light - Activates the user interface theme that is light in color.

§ Theme > Dark - Activates the user interface theme that is darker in color.

§ Toolbar - Shows or hides the Toolbar for quick access. Learn more »Toolbar 

§ Interfaces - Shows or hides the separate Interfaces view. Learn more »Interfaces 

§ Parameters - Shows or hides the separate Parameters view. Learn more »Parameters 

§ Sensors - Shows or hides the separate Sensors view. Learn more »Sensors 

§ Status Messages - Shows or hides the separate Status Messages view. Learn more »Status Messages 

§ Slots - Shows or hides the separate Slots view. Learn more »Slots 

§ Presets - Shows or hides the separate Presets view. Learn more »Presets 

§ Events - Shows or hides the separate Events view. Learn more »Events 

§ History - Shows or hides the separate History view. Learn more »History 

[Requires the MADRIX RADAR big data license and is deactivated if this license is not available.]

§ Log - Shows or hides the separate Log view. Learn more »Log 

§ Restore Default Window Layout - Applies the default settings for the graphical user interface, including

sizes and layout. As such, it resets any changes in size you made to the software window.
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Preferences Menu

These settings remain valid and set beyond any restart of the software.

§ Event Configuration... - Allows you customize the notifications presented or sent by the software when an

event occurs. Learn more »Events 

§ Options ... - Allows you to configure various important settings for the software. Learn more »Options

Devices Menu

Refers to tools that allow configuration of devices or communication with them in the network.

§ Discover Devices - Scans for all available Art-Net hardware interfaces in the network in order to find and

add them to the main list of devices [by sending an ArtPoll and the ArtPoll Reply functionality] as well as

connected RDM devices.
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Learn more »Art-Net [DMX Over Ethernet] 

§ Pause Monitoring - Deactivates the automatically generated RDM queries in order to temporarily halt

monitoring. 

- As a result, this also reduces network traffic and load.

- A corresponding in-app notification will show you this status change [which is displayed at the bottom of the

main window].

§ Patch Editor... - Opens the patching tool to quickly address your RDM devices [such as lighting fixtures].

Learn more »Patch Editor 

§ Identify All Devices (Set:IdentifyDevice) - Sends the Set:IdentifyDevice command On to all devices to

quickly enable this mode on all devices.

§ Stop Identifying All Devices (Set:IdentifyDevice) - Sends the Set:IdentifyDevice command Off to all

devices to quickly disable this mode on all devices.
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Language Menu

§ Deutsch - Activates the German language for the software user interface.

§ English - Activates the English language for the software user interface.

§ Español - Activates the Spanish language for the software user interface.

§ Français - Activates the French language for the software user interface.

§ Italiano - Activates the Italian language for the software user interface.

§     - Activates the Japanese language for the software user interface.

§ Português brasileiro - Activates the Brazilian Portuguese language for the software user interface.

§ русский - Activates the Russian language for the software user interface.

§ Türkçe - Activates the Turkish language for the software user interface.

§      - Activates the Simplified Chinese language for the software user interface.
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Help Menu

§ User Manual... - Opens this user guide, locally on your computer using your default web browser.

§ User Manual Online - Opens this user guide online by calling up a website using your default web browser.

This requires an internet connection.

§ Forum - Is an online link that will take you to the MADRIX Online Forum, where users and developers can

exchange ideas about MADRIX RADAR. This requires an internet connection.

§ Feedback - Is an online link that will open your web browser with the MADRIX Contact Form. If you wish,

please enter your comments into the form and send it to us. Thank you! This requires an internet connection.

§ Website - Is an online link for the MADRIX website »www.madrix.com. This requires an internet connection.

§ Launch Remote Support Tool... - Opens the external support tool provided with MADRIX RADAR. This

requires an internet connection. MADRIX technical support team may request that you launch this tool for further

assistance.

§ Check For Software Updates... - Checks online if a software update is available for downloading. This

requires an internet connection.

§ MADRIX KEY > Activate MADRIX KEY... - Allows you activate the MADRIX KEY.

Learn more »License System

§ MADRIX KEY > Update MADRIX KEY Firmware... - Allows you to update the firmware of your MADRIX

KEY. 

http://www.madrix.com
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§ License... - Opens the About window to show the MADRIX KEY and its MADRIX RADAR Licenses.

§ About - Provides information about MADRIX RADAR, the MADRIX KEY you might own, and legal information.

4.2 Toolbar

This topic includes:

§ Introduction

§ Overview

§ Customization

Introduction

The toolbar includes quick and direct access to commonly used features and functionality.

You can choose to show or hide it via menu View > Toolbar

Overview

Discover Devices - Re-scans for all Art-Net devices in the network [menu Devices > Discover

Devices].
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Pause Monitoring - Stops sending out RDM queries [menu Devices > Pause Monitoring].

Identify All Devices - Activates the identification mode for all devices that are listed in the list of

devices [menu Devices > Identify All Devices (Set:IdentifyDevice)].

Stop Identifying All Devices - Deactivates the identification mode for all devices that are listed in

the list of devices [menu Devices > Stop Identifying All Devices (Set:IdentifyDevice)].

Patch Editor - Opens the window of the Patch Editor [menu Devices > Patch Editor...].

Customization

The toolbar is located at the top of the application window by default. 

Use drag & drop on the drag-handle with the help of your mouse to re-position it to the outer left, outer

right, or bottom of the application window.

4.3 Customization

This topic includes:

§ Introduction

§ Restore Default Window Layout

§ Themes

§ Working With Lists

§ Showing Or Hiding Views

§ Re-Arranging The Layout
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Introduction

The user interface of the software can be customized to your preferences.

Restore Default Window Layout

§ Menu View > Restore Default Window Layout - Applies the default settings for the graphical user

interface, including sizes and layout. As such, it resets any changes you made to the software window.

Themes

You can change the general appearance of the software.

§ Menu Themes > Light - Activates the user interface theme that is light.

§ Menu Themes > Dark - Activates the user interface theme that is darker.

§ Learn more »Menu 
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Light Theme Dark Theme

Working With Lists

Overview

MADRIX RADAR mainly presents information in lists.

There are numerous options to adjust the views and the information presented to you.

Show Or Hide Columns

MADRIX RADAR allows you to choose which columns are presented in list views. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of a list.
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Show Column - A checkmark means that this particular column is shown.

Hide Column - No checkmark means that this particular column is hidden.

Sorting

You can easily adjust how items are sorted in lists.

Click on a column header in order to sort the entire list accordingly. 

Ascending Order - An up-arrow means that items are shown in ascending order.

Descending Order - A down-arrow means that items are shown in descending

order.

Re-Arranging Columns

You can easily change the order of columns in lists.

§ Left Mouse Click + Hold + Drag & Drop - Perform a click with your left mouse button on a column

header, continue to hold it, and move the header to its new position on the list. Release the mouse button in

order to let the column snap into its place.
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Showing Or Hiding Views

Undock View - Allows you to quickly undock a single view [in order to use it as separate window or to

rearrange the GUI layout].

Close View - Allows you to quickly close a single view. Alternatively, you can use the menu View.

Learn more »Menu 

 

Re-Arranging The Layout

You can completely rearrange all views in the software.

1] Undock a view.

2] Perform a left mouse click + hold on the top bar of the new view window and drag the view into its

designated place. 
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3] The view will snap into its new location.

4] A variety of locations is available to position views anew. [Vertically, three levels/rows are available.]
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5] Use the drag-handle that is positioned between views to increase or decrease the width of views.

 

6] In addition, views can be positioned on top of another. Single views can also be shown on a different monitor,

for example.

4.4 Tooltips

This topic includes:

§ Overview

Overview

When hovering over a user-interface control of software, MADRIX RADAR will provide a so-called tooltip after a short

while.
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These informative messages can provide additional information about the user interface or even underlying

technologies and standards, such as RDM and Art-Net.

You will find helpful information, especially regarding:

§ Any column heading of the various lists in the software

§ Table cells of the column Parameter of the Parameters view.
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5 Options

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

You can set up general and more specific options for MADRIX RADAR. 

To ensure optimal operation, we highly recommend to set up all options at first start according to

your preferences and a project's requirements.

Topics Of This Chapter

MADRIX RADAR Options include the following topics:

§ »Startup 

§ »Logging 

§ »RDM

§ »Database

§ »Timing

§ »Generators

5.1 Startup

This topic includes:

§ Overview

§ Options
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§ Notes

Overview

Software options include various settings regarding the MADRIX RADAR Software itself.

§ Go to the menu Preferences > Options... > Startup

[Keyboard shortcut: Ctrl + Alt + O > Startup]

§ Set up the options as explained below.

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

Options
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§ Start With Timeout (s) - Allows you to define the time the software waits in seconds [s] and delays the

startup process. MADRIX RADAR will not fully start until the time has passed. Is useful when MADRIX RADAR is

automatically started together with the operating system [that is, if MADRIX RADAR is a Startup App of

Windows.]

- This timeout is particularly useful when using network devices. The Windows operating system needs some

time to initialize such devices first. But MADRIX RADAR might be already loaded completely and as a result may

not detect the devices. This option prevents that and tries to ensure that devices are ready to be found before

the software scans for them or tries to communicate with them.

[This option is set to Off by default.]

- A new loading window will appear before the software starts. It shows a countdown and 2 options: 

- Start Now - Start the software immediately.

- Cancel Startup - Cancels the startup and MADRIX RADAR will not be launched. 

§ Enable System Proxy - Uses the system proxy. 

- A proxy is an optional intermediary for the client-server communication in a network.

- If you have set up and are using a system-wide proxy in the Windows operating system, enable this option here

in order to let MADRIX RADAR route its network data through it.

- Leave this setting disabled, if you are not using a system proxy or are unsure.

[This option is set to Off by default.]

§ Discover Devices - Scans for devices [interfaces and RDM device] in the network automatically as soon as

the software has been started [ArtPoll Reply]. 

- It might be advisable to turn this setting off, once a project is fully configured and set up. Otherwise, the

software scans for new devices every time the software is started [intentionally or unintentionally].

[This option is set to On by default.]
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§ Check For Software Updates - Automatically searches for software updates. When a new update is

available, a notification will be presented to you when starting the software. This requires an active internet

connection.

[This option is set to On by default.]

- Update ESTA Manufacturer List Automatically - Is only available if Check For Updates is enabled.

Automatically [and silently] updates the list of ESTA manufacturer IDs. This requires an active internet

connection. 

- If set to Off and a new update is available, a notification will be presented to you when starting the software in

order to choose downloading and updating the list.

- The list is stored under C:\Users\USER\Documents\MADRIX RADAR\cache

- You can manually check for updates using the menu Help > About > Check For Updates.

[This option is set to On by default.]

Notes

§ All Startup options will be saved locally on your computer.

5.2 Logging

This topic includes:

§ Overview

§ Options

§ Notes

Overview

Software options include various settings regarding the MADRIX RADAR Software itself.

§ Go to the menu Preferences > Options... > Logging

[Keyboard shortcut: Ctrl + Alt + O > Logging]
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§ Set up the options as explained below.

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

Options

§ Directory - Defines the location on your computer/system, where log files are saved. 

- Browse... - Allows you to choose a different folder or directory.

§ Rotation Time - Defines the time interval after which a new file is created. Enter any number and choose

between Hours, Days, and Weeks.

[The default value for this option is 1 day.]

§ Retention Time - Defines the time interval after which log files are deleted from the computer/system. Enter

any number and choose between Hours, Days, and Weeks.

[The default value for this option is 30 days.]
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Notes

§ All Logfile options will be saved locally on your computer.

5.3 RDM

This topic includes:

§ Overview

§ Options

§ Notes

Overview

RDM options include settings regarding the RDM protocol and RDM standard itself.

These include parameters that cannot be set automatically or should be adjusted by the user.

§ Go to the menu Preferences > Options... > RDM

[Keyboard shortcut: Ctrl + Alt + O > RDM]
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§ Set up the options as explained below.

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

Options

§ Port ID - Defines the specific identification number for MADRIX RADAR as an RDM controller to be able to

distinguish between possibly multiple RDM controllers in the network. 

[Valid values range from 1 to 255. This option is set to 1 by default.]

§ Self-Test Count - Defines the highest number regarding self-tests that is queried from devices. Refers to the

parameter Self-Test that may be reported by RDM Responders.

- RDM devices can include a number of self tests as defined and implemented by the manufacturer. These don't

necessarily have to be numbered consecutively and there is no recommend maximum count. 

- As such, you may want to choose to query for all 254 possible tests all the time. However, please note that this

can drastically increase the network traffic depending on the number of available RDM devices in the network.
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[Valid values range from 0 to 254. This option is set to 8 by default.]

§ Preset Limit - Defines the highest scene number that is queried from devices. 

- RDM devices can include a number of scenes as defined and implemented by the manufacturer. These don't

necessarily have to be numbered consecutively.

- As such, you may want to define the cap accordingly. However, please note that a high number can drastically

increase the network traffic depending on the number of available RDM devices in the network.

[Valid values range from 0 to 65534. This option is set to 16 by default.]

Notes

§ All RDM options will be saved locally on your computer.

5.4 Database

This topic includes:

§ Overview

§ Introduction

§ SQLite In Main Memory

§ SQLite File

§ PostgreSQL Server

§ Notes

§ Storage Space And Memory Requirements

Overview

Database options include settings regarding database usage and recorded RDM data.

§ Go to the menu Preferences > Options... > Database

[Keyboard shortcut: Ctrl + Alt + O > Database]



[Part 5] Options

//91www.madrix.com

MADRIX RADAR 1.2. Help And Manual

§ Set up the options as explained below.

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

Introduction

Database Management System

You can choose from 3 different Types:

§ SQLite In Main Memory 

[The default option is SQLite In Main Memory]

§ SQLite File

§ PostgreSQL Server 
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Please note: Choosing a database management system is subject to availability here in the software.

A different database system that is not provided as an option as listed above cannot be selected or

chosen.

Comparison

SQLite In Main Memory SQLite File PostgreSQL Server

§ Is the default option. § Is required when using the Big

Data/History feature and data

trends.

§ Is useful for short-term monitoring

and when data does need not be

saved and can thus be discarded

without ramifications.

§ Is useful when using MADRIX

RADAR only as configuration tool

for device addressing, for example.

§ Is useful for short-term monitoring

and the requirement to have data

stored beyond any restart of the

software.

§ Is useful when using MADRIX

RADAR only as configuration tool

for device addressing, for example.

§ Is the default option.

§ Does not require any configuration.

§ Only stores RDM-device data in the

temporary memory of the

computer [RAM].

§ Data quantities are thus limited to

the available system memory.

§ Data can thus be processed and

accessed very quickly.

§ Any data is discarded if the

software is closed in any way.

§ Only requires very little

configuration.

§ Writes a separate file onto the

hard drive in order capture, save,

and preserve recorded RDM-device

data.

§ Is an advanced system for data

management, which ensures data

integrity and data consistency, for

example.

§ Data quantities are thus limited to

the available hard-drive space.

§ Is a sophisticated database system

to capture, save, and preserve

recorded device data. 

§ Is an advanced system for data

management, which ensures data

integrity and data consistency, for

example.

§ The data is still available even if

the software is closed.

§ Can be set up on the same

computer as MADRIX RADAR

[locally] or on a different

server/computer [remotely].
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§ Data thus cannot be processed and

accessed as quickly as when

stored in the system's memory.

§ Always overwrites parameter

values and sensor data with

updated information and thus does

not enable data trends [that is, no

data history is available].

§ The data is still available even if

the software is closed.

§ Is automatically provided together

with the software's installation.

§ Is automatically provided together

with the software's installation.

§ Is not included in the software's

installation and needs to be

installed separately.

§ A database needs to be created in

PSQL after the installation. 

[The correct name of the

database, login information, and

more needs to be entered in the

options as explained below. See:

PostgreSQL Server] 

Switching Databases

When switching to a different option, you will be asked if you would like to scan for devices in the network again.

Please note: Each database holds their own devices. When switching databases, data will not be transferred from the

previous database to the new database.
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SQLite In Main Memory

Overview

SQLite can be used to record only temporary data within the computer's memory.

Options

It is not necessary to set up any options for this type of database management system [other than selecting it as the

chosen Type].
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SQLite File

Overview

SQLite can be used to create a separate database file. Data is then stored beyond any restart of the software.

Options

The following options are available and can be changed.

§ Type - Choose SQLite File

§ Data File - Defines the location of the database file on your computer.

- Browse... - Allows you to choose a different folder or directory.
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- By default, <User Directory>\Documents\MADRIX RADAR\MadrixRadarData.sqlite is selected. 

- A new file will be created when choosing a new directory.

PostgreSQL Server

Overview

PostgreSQL Server is required when using the Big Data/History feature.

MADRIX RADAR supports PSQL version 11 and higher.

Note: This type of database is not automatically installed together with MADRIX RADAR!
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§ You need to install this server-based database management system separately if you wish to use

it. 

§ It can be installed on the same computer system or you can choose a different server/computer.

Please see the following link for more information and the download:

»https://www.postgresql.org/

Local Usage

Overview

Install and configure PSQL on your local computer that also runs the MADRIX RADAR Software and set up the following

options in MADRIX RADAR to enable it.

1] PSQL Installation & Database Configuration

You need to set up PSQL before launching MADRIX RADAR or close the MADRIX RADAR Software

should it already be running.

§ Download PSQL.

§ Run the PSQL installer and install the database management system on the computer that also runs the MADRIX

RADAR Software.

- Remember the installation directory. It is required later.

§ Create a new database that MADRIX RADAR should use [via pgAdmin].

- Remember the name you gave the database as well as user names and passwords. They are

required later.

§ See »https://www.postgresql.org/ for the download and detailed documentation. 

- This user manual cannot provide full instructions on how to manage PSQL.

- Refer to an IT specialist if needed.

https://www.postgresql.org/
https://www.postgresql.org/
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2] Options In MADRIX RADAR

Set up the following options in the MADRIX RADAR Software to enable usage of PSQL.

§ Type - Choose PostgreSQL Server

§ Driver Directory - Defines the location of the required library files [*.dll] on your computer.

- Browse... - Allows you to choose a different folder or directory.

- Search for the correct directory on your computer or enter it manually. It is mandatory.

- Usually, the bin directory is within the PSQL installation folder: <PSQL Installation Directory>\<PSQL

Version>\bin [such as: C:\Program Files\PostgreSQL\12\bin]

- MADRIX RADAR supports PSQL version 11 and higher.

- Changing the library path requires a software restart in order to load the required files.

§ Server - Defines the network address of the PSQL server, that is the computer that hosts the PSQL database

management system.

- When using PSQL locally, the local address needs to be used: localhost, or alternatively 127.0.0.1

[The default value is localhost.]

§ Port - Defines the port that is used to establish the connection to the database. This option is available here

since the port can be changed in the configuration of PSQL. 

[The default value is the PSQL default port 5432.]

§ Database Name - Defines the name of the database. This can be especially useful when managing several

projects/databases and the need to distinguish between them. 

- Enter the name as defined by you during the creation of a corresponding database in PSQL!

[MADRIX RADAR provides a default name with MadrixRadarData. This is unlikely to be correct if you have not

chosen the same name during creation of the database.]

[Do not enter and use the default database of PSQL named postgre, since it includes incorrect data.]

§ User Name - Enter the name that is used to establish the connection to the database; as set up during the

configuration of PSQL. 

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]
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§ Password - Enter the password that corresponds with the user name; as set up during the configuration of

PSQL. Any input will be hidden. 

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]

Remote Server

Overview

MADRIX RADAR also provides the option to connect to a remote PSQL server.

1] Ethernet Connection

Establishing a remote connection requires the involved systems to be [physically] connected. 

In the most basic way, this means that the local computer that runs the MADRIX RADAR Software needs to be

connected to the remote server that hosts the PSQL database.

[Local and remote refers to two separate computer systems, which still may very well be within your physical reach.]
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§ Connect the MADRIX RADAR computer and the PSQL server over Ethernet network.

- Setting up unique and fixed IP addresses for each system is required.

- Make also sure to set up the correct subnet mask, which needs to be the same on both systems.

- Using a DNS is recommended, but not necessarily required [an IPv4 direct connection is possible].

- Refer to an IT specialist if needed.

[Connections over virtual networks, such as VPN, are not part of the explanation here.]

2] PSQL Installation & Database Configuration On The Remote Server

§ Download PSQL.

§ Run the PSQL installer and fully install the database management system on the remote server.

§ Create a new database that MADRIX RADAR should use [via pgAdmin].

- Remember the name you gave the database as well as user names and passwords. They are required later.

§ See »https://www.postgresql.org/ for the download and detailed documentation. 

- This user manual cannot provide full instructions on how to manage PSQL.

- Refer to an IT specialist if needed.

3] PSQL Configuration: Allow Remote Server

This configuration is required before setting up options in MADRIX RADAR under step 5]. Otherwise,

you need to restart MADRIX RADAR.

§ Connecting to a remote server is not enabled by default in PSQL. You need to allow a remote

connection by editing a configuration file. 

§ Navigate to the installation directory of PSQL and open the data folder [such as: C:\Program

Files\PostgreSQL\11\data].

§ Search or look for the file pg_hba.conf

§ Open the file with a text editor [such as Notepad].

§ Scroll to the end of the file and enter the MADRIX RADAR computer that should connect to this PSQL server.

- You have various options on how to enter the computer, such as using the IPv4 IP address, IPv6 IP address,

https://www.postgresql.org/
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and device name [DNS lookup required].

- An example for valid entry can look like this: host all all 172.16.1.10/24 md5

§ You have different options on what and how to allow remote connections.

§ Restart the PSQL server application after making these changes!

§ See »https://www.postgresql.org/ for detailed documentation about the pg_hba.conf file and how to enter

the computer.

- This user manual cannot provide full instructions on how to manage PSQL.

- Refer to an IT specialist if needed.

4] PSQL Installation On The Local Computer

Please install PSQL before launching MADRIX RADAR or close the MADRIX RADAR Software should it

already be running.

§ Download PSQL.

- The PSQL version can be higher than version used on the remote server.

§ Run the PSQL installer and partly install the database management system on the computer that also runs the

MADRIX RADAR Software. The only required components are Command Line Tools

- Remember the installation directory. It is required later.

§ Make sure that a fully functioning network connection has been established between the local

computer and the remote server!

§ See »https://www.postgresql.org/ for the download and detailed documentation. 

- This user manual cannot provide full instructions on how to manage PSQL.

- Refer to an IT specialist if needed.

https://www.postgresql.org/
https://www.postgresql.org/
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5] Options In MADRIX RADAR

Set up the following options in the MADRIX RADAR Software to enable usage of PSQL on a remote server.

§ Type - Choose PostgreSQL Server

§ Driver Directory - Defines the location of the required library files [*.dll] on your computer.

- Browse... - Allows you to choose a different folder or directory.

- Search for the correct directory on your computer or enter it manually. It is mandatory.

- Usually, the bin directory is within the PSQL installation folder: <PSQL Installation Directory>\11\bin

[such as: C:\Program Files\PostgreSQL\11\bin]

- Changing the library path requires a software restart in order to load the required files.

§ Server - Defines the network address of the PSQL server, that is the computer that hosts the PSQL database

management system.
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- When using PSQL remotely, the address of the remote server needs to be used.

- You have various options on how to enter the server, such as using the IPv4 IP address, IPv6 IP address, and

device name. 

- Example: 172.16.1.0

- Make sure to enter the correct address!

[The default value is localhost.]

§ Port - Defines the port that is used to establish the connection to the database. This option is available here

since the port can be changed in the configuration of PSQL. 

[The default value is the PSQL default port 5432.]

§ Database Name - Defines the name of the database. This can be especially useful when managing several

projects/databases and the need to distinguish between them. 

- Enter the name as defined by you during the creation of the corresponding database in PSQL on the remote

server.

[The default value is MadrixRadarData.]

§ User Name - Enter the name that is used to establish the connection to the database; as set up during the

configuration of PSQL on the remote server. 

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]

§ Password - Enter the password that corresponds with the user name; as set up during the configuration of

PSQL on the remote server. Any input will be hidden. 

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]
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Notes

§ All RDM database options set up here will be saved locally on your computer.

Storage Space And Memory Requirements

Overview

Since MADRIX RADAR uses database management systems to manage the data that is accumulated when working

with RDM devices, a lot of data might ultimately be handled.

The following examples try to estimate the required storage space for different scenarios. 
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Influencing Factors

Please note: A definite answer cannot be provided, since the needed storage or memory depends on a lot factors.

Such factors are amongst others:

§ Which database management system is used,

§ How many RDM devices should be managed,

§ How many RDM nodes are used,

§ How many parameters and sensors a device provides/reports,

§ How often data and status updates are queried from devices,

§ How many status messages or events may occur during the monitored period of time,

§ If the data should be recorded or not [Big Data/data history],

§ And more.

Examples

§ As you will see, using the Big Data features and a PSQL database can result in substantial amounts of data over

time. 

§ Example 01:

- 1000 RDM devices, with 25 parameters each, with 25 sensors each, are recorded for 1 month [data history]

into a PSQL database, while data is queried once per day and each sensor value creates an event.

- Estimation for needed storage/memory : ~100 MB

§ Example 02:

- 200 RDM devices, which support nearly all parameters each, with 50 sensors each, are recorded for 1 day

[data history] into a PSQL database, while data is queried every 5 minutes.

- Estimation for needed storage/memory : ~345 MB

§ Example 03:

- 2000 RDM devices, which support MIN/MAX values as well as recorded values, with 20 sensors each, are

recorded for 6 months [data history] into a PSQL database, while data is queried every 4 hours.
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- Estimation for needed storage/memory : ~5.2 GB

§ Example 04:

- 200 RDM devices, with 50 parameters each, with 50 sensors each, managed with SQLite (file) without data

history.

- Estimation for needed storage/memory : 2 MB

§ Example 05:

- 2000 RDM devices, with 10 parameters each, with 10 sensors each, managed with SQLite (in-memory) without

data history.

- Estimation for needed storage/memory : 4 MB

5.5 Timing

This topic includes:

§ Overview

§ Options

§ Notes

Overview

Timing options include various settings regarding the RDM timing preferences and request settings.

§ Go to the menu Preferences > Options... > Timing

[Keyboard shortcut: Ctrl + Alt + O > Timing]
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§ Set up the options as explained below.

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

Options

§ Sending Frame Time (ms) - Defines the minimum time interval between 2 RDM data packages on a DMX

line in milliseconds [ms].

- If this value is set too low, hardware interfaces may receive too many data packages, which can result in

overload.

- If this value is set too high, the maximum possible data transfer rate will not be reached, which can

unnecessarily increase the time required to obtain RDM information and data.

- Is mainly defined by the used hardware interfaces. As such, it is recommended to choose the lowest common

denominator across all connected interfaces.

[Valid values range from 25 to 1000. This option is set to 50 ms by default.]

§ Transaction Timeout (s) - Defines the maximum allowed time interval for RDM communication and

transactions in seconds [s]. Transactions include the RDM request of the controller as well as the reply/response
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of the responder.

- Any response that is received after this interval will be discarded and cannot be assigned to the original request

anymore.

- If this value is too low, all packages could be discarded in extreme cases.

- If this value is too high, responses may be assigned incorrectly to unrelated requests.

- The timeout correlates to the RDM Frame Time and the number of RDM devices connected to a single DMX port

of a hardware interface. The higher the RDM Frame Time and the more devices are connected to a single port,

the longer a response can take.

[Valid values range from 1 to 30. This option is set to 13 s by default.]

§ User Interface Update Interval (s) - Defines the time interval at which the software is refreshed in

seconds [s]. This refers to how often the graphical user interface [GUI] is being updated and can display new

and up-to-date information.

- If this value is too low, this may result in too many database queries. This, in turn, can lead to a high number

of hard-drive access operations [which can decrease a drive's lifespan due to its maximum read and write

cycles]. 

- If this value is too high, all or parts of the information that is shown in the software may be temporarily

outdated and not up to date anymore. 

[Valid values range from 1 to 3600. This option is set to 1 s by default.]

Notes

§ All Timing options will be saved locally on your computer.

5.6 Generators

This topic includes:

§ Overview

§ Options

§ Notes
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Overview

Timing options include various settings regarding the RDM timing preferences and request settings.

§ Go to the menu Preferences > Options... > Generators

[Keyboard shortcut: Ctrl + Alt + O > Generators]

§ Set up the options as explained below.

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

Options
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Overview

Generators refer to the built-in systems in MADRIX RADAR that automatically create and generate RDM data packages

[that is, RDM requests] which are sent to the RDM devices.

In fact, RDM devices only provide replies after receiving such requests. RDM devices will not independently send data

packages to a receiver, such as MADRIX RADAR.

§ Preset - Allows you to choose and customize 2 different sets of settings. Choose from Maintenance and

Monitoring.

- Maintenance includes much shorter time intervals by default and is recommended when actively and

temporarily checking on a project in order to quickly see and receive information, notifications, and data updates.

[As such, this generates much more RDM requests and thus much more data traffic on the network as a result.]

- Monitoring includes much longer time intervals by default and is recommended when passively monitoring a

project in order to be able to receive notifications on a regular basis and also for recording historical data.

Options

§ Request Parameters Every - Defines the time interval at which all generic RDM parameters of the project

are being queried/refreshed.

- Reference Time - In addition, you can set the start time/time interval/offset. [The default value is 12:00.]

- For example, updating values every 4 hours, starting at 12:00 will trigger the update 12:00, 16:00, 20:00,

24:00, 04:00, 08:00.

[Valid values range from 60 seconds to 24 hours. The default value for this option is 1 minute for Maintenance.

The default value is 24 hours for Monitoring.]

§ Request Sensor Values Every - Defines the time interval at which sensor values of all known sensors of

the project are being queried/refreshed.

- Reference Time - In addition, you can set the start time/time interval/offset. [The default value is 12:00.]

- For example, updating values every 4 hours, starting at 12:00 will trigger the update 12:00, 16:00, 20:00,

24:00, 04:00, 08:00.

[Valid values range from 60 seconds to 24 hours. The default value for this option is 1 minute for Maintenance.

The default value is 1 hour for Monitoring.]

- Store History - Allows you to record data over time. This requires the MADRIX RADAR big data license. If

disabled and/or no corresponding license is available, previous values will always be overwritten with

corresponding new values. Learn more »History 
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[Historical data can include sensor values as well as sensor value events.]

§ Request Status Messages Every - Defines the time interval at which the status messages of all known

devices of the project are being queried/refreshed.

- Reference Time - In addition, you can set the start time/time interval/offset. [The default value is 12:00.]

- For example, updating values every 4 hours, starting at 12:00 will trigger the update 12:00, 16:00, 20:00,

24:00, 04:00, 08:00.

[Valid values range from 60 second to 24 hours. The default value for this option is 1 minute for Maintenance.

The default value is 1 hour for Monitoring.] 

- Store History - Allows you to record messages over time. This requires the MADRIX RADAR big data

license. If disabled and/or no corresponding license is available, previous values will always be overwritten with

corresponding new messages. Learn more »History 

Notes

§ All Generators options will be saved locally on your computer.
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6 Using The Software [Views]

This topic includes:

§ Introduction

§ Overview

§ Topics Of This Chapter

Introduction

The user interface of MADRIX RADAR mainly includes different views, such as device overview, parameters, and

events. The following chapters will explain each view or feature in more detail.

Overview

§ For any hardware-interface monitoring, use the Interfaces view.

§ For any RDM device configuration, the Devices and Parameters views are most important. In addition, the

Patch Editor is a extremely useful tool for device addressing.

§ For device monitoring and project supervision, the Sensors and Events views are most important. The

Status Messages view can also be useful.

§ For Big Data and data recording, the History view is most important.

Topics Of This Chapter

§ »Interfaces 

§ »Devices [Main View] 

§ »Parameters 
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§ »Sensors

§ »Status Messages 

§ »Slots 

§ »Presets 

§ »Events 

§ »Event Notifications 

§ »History 

§ »Log 

§ »Patch Editor 

§ »Snapshots 

6.1 Interfaces

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search

§ Customization

Introduction

Interfaces and nodes are often part of any project installation. While not separately identified by the RDM

specifications, MADRIX RADAR provides built-in mechanisms to monitor their status as well.

Requirements and conditions for interface monitoring:

§ Interfaces need to support RDM over Art-Net.

[This is also a general requirement for nodes/interfaces to be used with MADRIX RADAR.]

§ Monitoring of interfaces is not tied to the license system of the software. Interfaces do not need a separate

license validation.

[»License Model]
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Detecting lost connections for interfaces is possible when no more data or status information is received by the device,

for example:

§ For devices with a hardware failure.

§ If the RDM features of a device are disabled.

§ If the assignment of universe(s) has changed.

Overview

By default, the following information is provided since the following columns are enabled in the list:

# Represents the device numbering as index and is especially useful for referencing

interfaces in the list or seeing the total number of found interfaces. 

Status May show an orange icon [that is, a warning triangle] if problems are detected. In

addition, a tooltip with specific information is provided [via mouse-over].

Warnings may include, for example:

§ the connection to this interface has been lost

§ the interface is not capable of transmitting RDM data, or RDM is

currently disabled



[Part 6] Using The Software [Views]

//116www.madrix.com

MADRIX RADAR 1.2. Help And Manual

Network Shows the network IP address of the network adapter, to which the interface is

connected. [TCP/IPv4] [This information refers to »Art-Net.]

Network Name Shows the name of the network adapter.

Interface IP Address Shows the IP address of the hardware interface. [This information refers to »Art-Net.]

Interface Short Name Shows the short name of the hardware interface. [This information refers to »Art-

Net.]

Interface Long Name Shows the long name of the hardware interface. [This information refers to »Art-Net.]

Interface Firmware Shows the current firmware version of the hardware interface. [This information refers

to »Art-Net.]

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Open Interface

Configuration Via

HTTP...

Opens a new web-browser window using the IP address of the interface in order to

access the web configuration of the device. The interface needs to support this

feature. 
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Delete Removes the interface from the list. [Keyboard shortcut: Del]

A progression window will be shown if the process of deleting a large number of

interfaces at once should take longer than 1 second.

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected row or rows [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, aur will include results for AURA.

- You may specify certain columns by using a colon [:].

- For example: Desc:Vol shows all lines that include voltage status information by referencing the column

Description, for example.
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Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

# Shows or hides the Index column.

Status Shows or hides the Status column.

Network Shows or hides the Network column.

Interface IP Address Shows or hides the Interface IP Address column.

Interface Short Name Shows or hides the Interface Short Name column.

Interface Long Name Shows or hides the Interface Long Name column.

Interface Firmware Shows or hides the Interface Firmware column.
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6.2 Devices [Main View]

This topic includes:

§ Introduction

§ Overview

§ Editing And Changing Values

§ Context-Menu

§ Search

§ Customization

Introduction

The list of devices is the main view of the software.

It shows all found RDM devices [that is, luminaires and lighting fixtures for example] and their respective settings,

parameters, and characteristics. 

This also includes the hardware interfaces to which they are connected.

Overview

By default, the following information is provided since the following columns are enabled in the list:
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# Represents the device numbering as index and is especially useful for referencing

devices in the list or seeing the total number of found RDM devices. 

Status May show an orange icon [that is, a warning triangle] if sensor values of an RDM

device are out of the valid range. In addition, a tooltip with specific information is

provided [via mouse-over].

Network Shows the network IP address of the network adapter, to which the interface is

connected. [TCP/IPv4] [This information refers to »Art-Net.]

Network Name Shows the name of the network adapter.

Interface IP Address Shows the IP address of the hardware interface to which the RDM device is connected.

[This information refers to »Art-Net.]

Interface Short Name Shows the short name of the hardware interface to which the RDM device is

connected. [This information refers to »Art-Net.]

Interface Long Name Shows the long name of the hardware interface to which the RDM device is connected.

[This information refers to »Art-Net.]

Interface Firmware Shows the current firmware version of the hardware interface to which the RDM device

is connected. [This information refers to »Art-Net.]

Device Label Can be edited. Shows the currently set name or description of the RDM device.

Unique ID Represents a unique identifier of the RDM device. It is shown as HEX [without 0x] and

using a colon [:] as separator. The first part is the ESTA ID of the manufacturer and

the second part is a number, which can be freely defined by the manufacturer.

ESTA Manufacturer Shows the name of the manufacturer based on the list of manufacturers as published

by ESTA. [It is retrieved from the first part of the RDM-device ID.]
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Identify Can be edited. Allows you to choose/activate the built-in identification mode of the RDM

device if available from the device.

DMX Universe Shows the currently assigned DMX universe for the RDM device. [Learn more

»Glossary]

DMX Start Address Can be edited. Shows the currently set DMX start address of the RDM device. [Learn

more »Glossary]

DMX Personality Can be edited. Shows the currently set DMX personality of the RDM device. This can

also be referred to as operation mode of the RDM device.

Editing And Changing Values

Overview

§ In general, this overview shows information provided by the RDM device.

§ In specific cases, the edit icon [that is, a pen] shows that the respective information/column can be edited by

you.

Single Edits

§ Left Mouse Click + Hold - Allows you to select a single cell.

§ Left Mouse Double-Click - Perform a double-click with your left mouse button on a value in order to edit it.

§ Keyboard shortcut: F2

§ Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.
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You may be presented with different choices for the specific parameter.

You may be able to directly enter numbers or text as input.

Multi-Edits

§ Ctrl + Left Mouse Click or Shift + Left Mouse Click + Select First List Entry + Select Last List

Entry - Allows you to select multiple items in the list.

§ Ctrl + A - Selects all devices in the list.

§ F2 - Activates the edit mode for multiple devices at once. Select multiple devices first.

§ Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.

§ Please note that different devices may support different ranges of values for a specific parameter.

- If you set a specific value for a parameter, it will only be sent to devices that support it.

- Certain parameters, such as DMX personality, will only set a specific number. If devices have different modes

implemented for the different numbers, the mode 5 might not be the same for every device.

Valid Values And Limits

The valid values for each parameter are defined by the RDM device and its set of features [such as DMX Personality],

the RDM standard [such as Identify], or a different standard [such as DMX Start Address for DMX512].
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Visual Feedback For Edits

The software will show you if any changes you have made are set successfully or not. This status is shown for a

couple of seconds after each change.

Green - The RDM device reported back that the changes

were successfully set.

Yellow - The request is currently pending.

Red - The RDM device could not successfully set the new

value or the request timed out. Learn more »Missing

Responses From RDM Devices

If you are editing several devices, the list cell can split in

the according number of selected devices and show each

status individually.
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Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on a device.

Edit Allows you to change the entry [if it can be edited]. [Keyboard shortcut: F2]

Open Interface

Configuration Via

HTTP...

Opens the configuration website of the device using the default web browser.

Identify Devices

(Set:IdentifyDevice)

Allows you to choose/activate the built-in identification mode of the RDM device if

available from the device. This usually means that the device will fully flash in white.

[Keyboard shortcut: F7]

Stop Identifying

Devices 

(Set:IdentifyDevice)

Stops the identification mode. [Keyboard shortcut: Shift + F7]

Capture Presets

(Set:CapturePreset)...

Sends the RDM request Set:CapturePreset to the device. This parameter can

only be set. Its status cannot be received and thus it cannot be shown in the

overview. The device needs to support this parameter. Otherwise, the option is

deactivated.
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Reset Devices

(Set:ResetDevice)...

Sends the RDM request Set:ResetDevice to the device. This parameter can only

be set. Its status cannot be received and thus it cannot be shown in the overview.

The device needs to support this parameter. Otherwise, the option is deactivated.

Delete Removes the currently selected devices from the list and database. [Keyboard

shortcut: Del]

A progression window will be shown if the process of deleting a large number of

devices at once should take longer than 1 second.

Copy Cell To Clipboard Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected row or rows [that is, all device information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all devices in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: Interf:MAD shows all lines where a MADRIX hardware interface is connected by referencing

the column Interface Long Name/Interface Short Name, for example. If no column is shown that

includes 'Interf', MADRIX RADAR will search all shown columns for the specifically entered term.
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Customization

MADRIX RADAR allows you to choose which parameters are presented in this view. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

# Shows or hides the Index column.

Status Shows or hides the Status column.

Interface-Specific Parameters Shows or hides any parameters that are related to hardware

interfaces.
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Product-Specific Parameters Shows or hides any parameters that are related to the

product.

Control Parameters Shows or hides any parameters that are related to controlling

the RDM device.
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DMX Parameters Shows or hides any parameters that are related to configuring

the DMX512 settings of the device.

Power/Lamp Parameters Shows or hides any parameters that are related to

power/lamp settings.

Configuration Parameters Shows or hides any parameters that are related to the

configuration of the RDM device.

Dimmer Parameters Shows or hides any parameters that are related to dimmer

packs.
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Communication Status Parameters Shows or hides any parameters that are related to

communication with RDM devices.

Manufacturer-Specific Parameters Shows or hides any manufacturer-specific parameters.

Each unique manufacturer-specific parameters receives its

own column. Manufacturer-specific parameters will only be

grouped if all included parameters are or define the same.

For example, if you wish to sort via Product Detail ID, make sure to activate column Product Detail and click on the

corresponding header to sort in ascending or descending order.

6.3 Parameters

This topic includes:

§ Introduction

§ Overview

§ Editing And Changing Values

§ Context-Menu

§ Search

§ Options

§ Customization
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Introduction

The Parameters view shows all RDM parameters [PIDs including fixed parameter IDs as well as manufacturer-specific

IDs] that are supported by the currently selected device [or even currently selected devices].
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Overview

By default, the following information is provided since the following columns are enabled in the list:

# Represents the parameter numbering as index and is especially useful for referencing

parameters in the list. 

Parameter Shows each specific parameter that is supported.

Value Shows the current value for each parameter.

Associated PIDs Shows the specific PID or PIDs that are assigned to the parameter.

Editing And Changing Values

Overview

§ In general, this overview shows information provided by the RDM device.

§ In specific cases, the edit icon [that is, a pen] shows that the respective information can be edited by you.

Editing

§ Left Mouse Double-Click - Perform a double-click with your left mouse button on a value in order to edit it.

- Keyboard shortcut: F2

- Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.
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You may be presented with different choices for the specific parameter. 

In this example, 0x00 or 0x01 is the value that will be sent over RDM.

You may be able to directly enter numbers or text as input.

When having selected several devices in the Devices view and their parameters have

different values, the software will display this accordingly.

When changing a value, the change will be made for all selected RDM devices that

support this parameter. 

Valid Values And Limits

The valid values for each parameter are defined by the RDM device and its set of features [such as DMX Personality],

the RDM standard [such as Identify], or a different standard [such as DMX Start Address for DMX512].

Visual Feedback For Edits

The software will show you if any changes you have made are set successfully or not. This status is shown for a

couple of seconds after each change.

Green - The RDM device reported back that the changes

were successfully set.

Yellow - The request is currently pending.

Red - The RDM device could not successfully set the new

value or the request timed out. Learn more »Missing

Responses From RDM Devices
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If you are editing several devices, the list cell can split in

the according number of selected devices and show each

status individually.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on a device.

Edit Allows you to change the entry [if it can be edited]. [Keyboard shortcut: F2]

Request Parameters

(Get:ParameterId)

Sends a new request to the device in order to obtain the latest parameter values,

which includes all personalities and their corresponding descriptions. [Corresponds to

the Get-command of the specific PID if available.]

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected row or rows [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.
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Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: val:MAD shows all lines where MADRIX might be included in a product description for example

by referencing the column Value, for example.

Options

You can set up specific settings for Parameters in the Options.

Learn more »Timing 

Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.
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§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

# Shows or hides the Index column.

Parameter Shows or hides the Parameter column.

Value Shows or hides the Value column.

Associated PIDs Shows or hides the Associated PIDs column.

6.4 Sensors

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Visual Feedback

§ Search

§ Options

§ Customization
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Introduction

The Sensors view shows all sensors that are available for the currently selected device or even currently selected

devices.

Overview

By default, the following information is provided since the following columns are enabled in the list:

Sensor Represents the sensor numbering and is especially useful for referencing sensors in

the list.  [As defined by the RDM standard, these start with the index 0.]

When having selected multiple devices, you may see that sensors have the same index
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number. This is implemented intentionally in this way to be able to compare [the

same] sensors of different devices.

Status Shows a helpful graphical representation of the sensor value. This includes:

- Current value [black line],

- Sensor optimal values [green],

- Sensor tolerated values [yellow to orange],

- Sensor minimum and maximum [red].

See also Visual Feedback

Description Shows the name of the sensor [as reported by the device].

Type Shows the type of the sensor [as reported by the device].

Total MIN Shows the absolute minimum value the sensor can read and report [as defined by the

sensor/manufacturer].

Normal MIN Shows the minimum sensor value, which is the lowest acceptable value for the device

for normal operation.

Detected MIN Shows the lowest sensor value that has been reported by the device. Please note that

it depends on how the manufacturer has implemented this feature. The manufacturer

decides what is being read and what is being reported and when. [The device needs to

support the Recorded Value functionality as indicated by Recording Support.]

Present Value Shows the current value of the sensor.

Detected MAX Shows the highest sensor value that has been reported by the device. Please note that

it depends on how the manufacturer has implemented this feature. The manufacturer

decides what is being read and what is being reported and when. [The device needs to

support the Recorded Value functionality as indicated by Recording Support.]
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Normal MAX Shows the maximum sensor value, which is the highest acceptable value for the device

for normal operation.

Total MAX Shows the absolute maximum value the sensor can read and report [as defined by the

sensor/manufacturer].

Recorded Value Shows the currently recorded value [as reported by the device].

Recording Support Shows if the device supports this functionality. Devices can either support recording the

current sensor value, detect and store minimum and maximum values, both recording

and detecting, or none.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Request Sensor

Values

(Get:SensorValue)

Requests up-to-date status information for the selected sensor.
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Record Sensor Values

(Set:RecordSensors)

Sends the RDM request Set:RecordSensors to the device in order to store the

value in the device and request it via Get:SensorValue. This parameter can only be set.

Its status cannot be received and thus it cannot be shown in the overview. This will

record the current sensor value in the RDM device itself.

Clear Sensor Values

(Set:SensorValue)

Sends the RDM request Set:SensorValue to the device. This resets the sensor. This

parameter can only be set. Its status cannot be received and thus it cannot be shown

in the overview.

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected row or rows [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Visual Feedback

The software will show you if sensors have reported serious or critical values.

If values are out of the optimal range, the entire row will be shown in the same color as would the status indicate:

- Sensor tolerated values [yellow to orange]

- Sensor minimum and maximum [red]

No visual changes are made to the row if values are within optimal range.
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Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: Sen:Temp shows all lines where a temperature sensor is connected by referencing the column

Sensor, for example.

Options

You can set up specific settings for Sensors in the Options.

Learn more »Timing 
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Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Sensor Shows or hides the Sensor column.

Status Shows or hides the Status column.

Description Shows or hides the Description column.

Type Shows or hides the Type column.
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Total MIN Shows or hides the Total MIN column.

Normal MIN Shows or hides the Normal MIN column.

Detected MIN Shows or hides the Detected MIN column.

Present Value Shows or hides the Present Value column.

Detected MAX Shows or hides the Detected MAX column.

Normal MAX Shows or hides the Normal MAX column.

Total MAX Shows or hides the Total MAX column.

Recorded Value Shows or hides the Recorded Value column.

Recording Support Shows or hides the Recording Support column.

6.5 Status Messages

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search

§ Options

§ Customization

Introduction
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RDM devices may report back specific occurrences on their own [as supported by the RDM device and as defined by

the manufacturer]. As such, you could say that they can have their own log implemented.

The Status Messages view shows all received status messages for the currently selected device.

Overview

By default, the following information is provided since the following columns are enabled in the list:

Timestamp Shows the local time when the status message has been requested. [YYYY/MM/DD 

HH:MM:SS]
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Type Shows the type of message [as defined by the RDM standard].

Description Shows a more in-depth explanation of the message including values [as reported by

the device].

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Request Status

Messages

(Get:StatusMessages

)

Requests up-to-date status messages.

Clear Status

Messages

(Set:ClearStatusId)

Sends the RDM request Set:StatusMessages to the device. This clears all status

messages on the device. This parameter can only be set. Its status cannot be received

and thus it cannot be shown in the overview.

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]
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Copy Rows To

Clipboard

Copies the currently selected row or rows [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: Desc:Vol shows all lines that include voltage status information by referencing the column

Description, for example.

Options

You can set up specific settings for Status Messages in the Options.

Learn more »Timing 
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Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Timestamp Shows or hides the Timestamp column.

Type Shows or hides the Type column.

Description Shows or hides the Description column.

6.6 Slots

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search
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Introduction

The Slots view shows all reported slots for the currently selected device.

Since this is specific to a device [as defined and implemented by the manufacturer], no information can be edited.

Usually and if available, slots represent the DMX personality of a device, that is which functionality is assigned to which

channel [for example, Master Dimmer, Red Channel, Green Channel, Blue Channel, White Channel, Intensity, etc.].

Overview

By default, the following information is provided since the following columns are enabled in the list:
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Use the arrows in order to show these slots by expanding the view [or collapsing it

back].

Offset Represents the channel number of the device. It also shows primary and secondary

slots. Secondary slots specify primary slots more precisely.  [As defined by the RDM

standard, these start with the index 0.]

Description Shows a more in-depth explanation of the slot [as reported by the device].

Type Shows the type of the slot [as reported by the device].

Default Value Shows the default value of the slot [as reported by the device].

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Request Slot

Information

(Get:SlotInfo)

Sends a request to the device in order to manually update the provided slot

information.
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Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: Desc:Int shows all lines that include intensity slots by referencing the column Description,

for example.

6.7 Presets

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search

§ Options

§ Customization
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Introduction

RDM devices may include specific scenes. As such, you could say that they can have their own log implemented.

The Presets view shows all received scenes for the currently selected devices.
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Overview

By default, the following information is provided since the following columns are enabled in the list:
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Preset Shows the scene number that the device has stored [as reported by the device].

Fade-In Time Shows the defined fade-in time for the current scene.

Fade-Out Time Shows the defined down fade for the previous scene or active look. 

Wait Time Shows the defined time the device remains at the current scene before playing the

next scene.

Programmed State Shows if a preset scene is not programmed [0], if it is programmed [1], or if it can

only be read since it was programmed by the manufacturer. 

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Edit Preset Settings

(Set:PresetStatus)...

Opens a new window to modify a preset.
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Preset Number - Defines the scene number.

Fade-In Time (s) - Defines the fade-in time [in seconds].

Fade-Out Time (s) - Defines the down fade [in seconds].

Wait Time (s) - Defines the wait time [in seconds].

Confirm with OK. Or abort the process via Cancel.

Clear Presets

(Set:PresetStatus)

Removes the currently selected presets.

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.
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Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: Desc:Vol shows all lines that include voltage status information by referencing the column

Description, for example.

Options

You can set up specific settings for Scenes in the Options.

Learn more »RDM 

Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.
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§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Preset Shows or hides the Preset column.

Fade-In Time Shows or hides the Fade-In Time column.

Fade-Out Time Shows or hides the Fade-Out Time column.

Wait Time Shows or hides the Wait Time column.

Programming State Shows or hides the Programming State column.

6.8 Events

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search

§ Customization

§ Event Configuration
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Introduction

MADRIX RADAR sends and receives requests from connected RDM devices, which include valuable information, such

as sensor values.

In addition to merely requesting and receiving information, MADRIX RADAR will apply its own logic in order to create

events for you. By checking and validating incoming data, MADRIX RADAR provides actionable reports for you.

This functionality is not part of the RDM specification and provides great additional value when using MADRIX RADAR.

As such, it is an important tool for monitoring and supervising the project.

You can choose to show events only in the software itself, or set up custom notifications according to your

requirements [see the next chapter].

The Events view shows all occurred events from all RDM devices.

In general, please allow for several minutes of time to pass before events are registered and shown.

Overview

By default, the following information is provided since the following columns are enabled in the list:
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Timestamp Shows the local time when the event occurred. [YYYY/MM/DD  HH:MM:SS]

Category Shows the kind of event [including Info, Warning, Critical, Fatal].

Network Shows the network IP address of the network adapter, to which the interface is

connected. [TCP/IPv4] [This information refers to »Art-Net.]

Network Name Shows the name of the network adapter.

Interface IP Address Shows the IP address of the hardware interface to which the RDM device is connected.

[This information refers to »Art-Net.]

Unique ID Is also shown in the Devices view. Represents a unique identifier of the RDM device. It

is shown as HEX [without 0x] and using a colon [:] as separator. The first part is the

ESTA ID of the manufacturer and the second part is a number, which can be freely

defined by the manufacturer. 

Sub-Device ID Shows a value of 0 if the device is a so-called root device. For all others, the sub-

device ID for devices that have one is shown.

DMX Universe Shows the currently assigned DMX universe for the RDM device. [Learn more

»Glossary]

Domain Shows to which type entry is assigned to, such as Devices.

Item Shows a specific reference of where the event occurred if available. 

Such reference could be Curve, DMX Personality, Language Capability,

Lock State, Modulation Setting, Parameter, Output Response Time,

Preset, Self-Test, Sensor, or Slot [and includes the corresponding item number].

Label Shows the quick identifier of the specific event.
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Description Shows an in-depth explanation of the event for your information and as basis to act

upon.

§ All events will be logged.

§ Events are stored temporarily. They are shown until the software is closed.

§ In addition, events referring to history data will be stored persistently in the database and shown in the History

View [Sensor Value Events].

§ A maximum of 1,000 entries can be shown.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Go To... Focuses on the corresponding device in the Devices view, the corresponding

interface in the Interfaces view, and also shows the event in the History view if

recorded data is available. 

Clear Events Removes all logged items from the list.
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Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: Desc:Vol shows all lines that include voltage status information by referencing the column

Description, for example.

Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.
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§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Timestamp Shows or hides the Timestamp column.

Category Shows or hides the Category column.

Network Shows or hides the Network column.

Interface IP Address Shows or hides the Interface IP Address column.

Unique ID Shows or hides the Unique ID column.

Sub-Device Id Shows or hides the Sub-Device ID column.

DMX Universe Shows or hides the DMX Universe column.

Domain Shows or hides the Domain column.
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Label Shows or hides the Label column.

Description Shows or hides the Description column.

Event Configuration

You can customize and set up if and how you would like to be notified in case of reported events.

Continue with »Event Notifications 

6.9 Event Notifications

This topic includes:

§ Introduction

§ Event Configuration

§ Menu

§ Actions

§ Categories

§ Events

Introduction

In addition to the regular Event view, you can customize and set up if and how you would like to be notified in case of

events.

When an event occurs, it is categorized, which in turn triggers the assigned actions.

[Alternatively, you can choose to leave the useful defaults as provided.]
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By default, all events are shown in the Events view [except for category Validation].

First, learn more about »Events 

Event Configuration

§ Go to the menu Preferences > Event Configuration...

[Keyboard shortcut: Ctrl + Alt + E]
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Menu

§ New Event Configuration - Resets any configuration of Actions, Categories, or Events that may have taken

place and restores the default settings. All custom actions will be deleted and the event and category mappings

will be reset.

[Keyboard shortcut: Ctrl + N]

§ Open Event Configuration... - Loads a previously saved Event Configuration file [of the file type *.revcx]. 

[Keyboard shortcut: Ctrl + O]

§ Save Event Configuration - Stores an Event Configuration in an external file [of the file type *.revcx] in

order to preserve it.

- Sensible information [such as, user name, password, and command line commands] will be saved and

encrypted with the Advanced Encryption Standard AES 256.

[Keyboard shortcut: Ctrl + S]

§ Save Event Configuration As... - Stores the Event Configuration as a separate, duplicate file. And allows

you to choose a different name.

- Sensible information [such as, user name, password, and command line commands] will be saved and

encrypted with the Advanced Encryption Standard AES 256.

[Keyboard shortcut: Ctrl + Shift + S]

§ Close - Closes the Event Configuration window. 

[Keyboard shortcut: Ctrl + F4]
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Actions

Overview

Actions allow you to define the kind of notification or action that should be triggered when an event occurred.

By default, events are always shown in the Events view [except category Validation].. Learn more »Events 

Add Action - Creates a new action.

Remove Action - Removes the currently selected action. [Select an action via the selection field to

the right. See Select Action below.]

Edit Action Label - Allows you to change the name of the action.

Select Action - Allows you to choose which action configuration you would like to see or edit.

Adding Actions

1] Click + to create a new action.

2] Choose which type of notification. Choose from E-Mail or Shell Script.

 

3] Configure the notification as shown below.
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E-Mail Notifications

Allows you to let the software periodically send e-mail notifications to you automatically.

A message includes a text file [of the file type *.txt] in the attachment which contains all events that occurred. 

You can choose to have messages sent only in case events were reported or always; even if no events occurred.

Configure all settings as described below.
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§ Receiver Address - Enter the e-mail address or address to which send the automatic reports [for example,

receiver@company.com]. 

- Enter one e-mail address or enter several addresses and separate them via spaces [ ], commas [ , ], or

semicolons [ ; ].

§ Server - Enter the e-mail server's address from which e-mails are sent [for example, mail.company.com].

- Port - Enter the communication port that is used by your e-mail server.

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]

§ Sender Address - Enter the e-mail address from which e-mails are sent [for example,

maintenance@company.com]

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]

§ User Name - Enter the name that is used to establish the connection to the e-mail server.

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]

§ Password - Enter the password that corresponds with the user name. Any input will be hidden.

[Any input will be saved and encrypted with the Advanced Encryption Standard AES 256.]

§ Send Every - Defines how often e-mail messages are sent. Enter any number and choose the time

interval.

- Valid values range from 1 minute to 12 months. The default value is 1 day.

- Starting At - Allows you to define the start date, when the software begins sending messages. Set up the

date and time accordingly.

- If the date is set to a past point in time, one message will be sent retroactively.

§ Send an attachment with the following text, if no events occur  - If enabled, allows you to

receive messages even if no particular event has occurred.

- Enter any text in the input field. [By default, it includes No events occurred in the recent

interval.]

§ Subject - Enter the subject line of e-mails. [By default, it includes Status Report]

§ Body - Allows you to enter any additional text in addition to the automatically generated header and footer

created by the software.

§ Test - Directly tries to send an e-mail [with the current settings] in order to test the functionality and server

settings [without having to wait until an event occurs].

mailto:maintenance@company.com]
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§ Make sure to confirm any changes with Apply.

Shell Script Notifications

Overview

Allows you to execute commands in the PowerShell. 

PowerShell is an integral tool of the Windows operating system for advanced scripting. It is already installed and

available with Windows 10.

Configure all settings as described below.
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§ Commands - Enter the command which you would like to execute.

- See below for examples.

§ Test - Directly executes the entered command in order to test its functionality [without having to wait until an

event occurs].

Command Examples

Executing Shell Scripts via the PowerShell provides numerous possibilities. Here are several examples on how to use

these capabilities:
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§ Let your computer make a short beep sound: 

[console]::beep(1000,400)

§ Start another software application, such as MADRIX 5:

start-process -FilePath "C:\Program Files\MADRIX5\Madrix.exe"

[C:\Program Files\MADRIX5\Madrix.exe is the default installation directory. MADRIX 5, in turn, could for example

automatically start a Cue List, run a script or macro, or control a lighting fixture as a status light.]

§ Start a batch file:

start-process -FilePath "C:\Test\MyTestFile.bat"

[C:\Test\MyTestFile.bat define the directory and specific file to launch. Batch files are scripting files that can start

a more complex process or several tasks at once.]

§ Write into a text file:

"Alert" | Out-File C:\test\process.txt

[Alert is the string that is written into the file. C:\test\process.txt define the directory and specific file to write

into. Directory and file need to exist before the functionality can be used. MADRIX 5 Script can read from text

files, for example.]

§ Sending HTTP requests to MADRIX 5:

Invoke-webrequest -URI http://10.0.0.49/index.html?SetStorage=S1P5

[See the MADRIX 5 HTTP Remote Control Commands at »help.madrix.com for more information.]

§ Sending HTTP requests to MADRIX AURA:

Invoke-WebRequest -URI http://10.84.0.8/remote.cgi?Intensity

[See the MADRIX AURA User Manual at »help.madrix.com for more information.]

§ Combining several commands into a single HTTP request [for MADRIX 5 for example]:

Invoke-webrequest -URI http://10.0.0.49/index.html?SetAudioOutputMute=1"&"SetBlackout=1

[The & character needs to be embedded into "" regarding PowerShell scripting.]

Removing Actions

1] Select the action you wish to remove.

2] Click -

http://help.madrix.com/
http://help.madrix.com/
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Categories

Overview

The Categories tab allows you to define different classes of events. This allows for more granular filtering and sorting

[in the Events view, for example]. And you can set different notification settings [actions] for each category.

All categories are listed alphabetically.

By default, 4 categories have been defined [Critical, Info, Validation, Warning].

Configure categories as described below.
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Adding A New Category

1] Click + in the upper left corner to create a new category.

2] Enter a name for the new category. Confirm with OK. Abort the process via Cancel.

 

Renaming A Category

1] Click Edit next to the category name you wish to rename.

2] Change the current label or enter a new name. Confirm with Enter. Abort the process with Cancel.

 

Removing A Category

1] Click - next to the category name you wish to remove.

2] Confirm with Yes. Abort the process via Cancel.
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Please note: Any event that was assigned to a category that has now been removed is no longer

assigned to a category.

Assigning Actions [Notifications]

Assign Action - Assigns an action to the particular category. 

- A new window opens to choose the action. Confirm with OK. Abort the process via Cancel. 

- A specific action can only be assigned once per category.

- You can assign any number of actions.

- Display refers to in-app notifications in the Events view.

Remove Assigned Action - Removes the currently selected action from the category again. Select

the action first.

Prioritize Assigned Action - Allows you to rearrange assigned actions. Actions will be processed

consecutively. Actions higher in the list will be processed first.

Deprioritize Assigned Action - Allows you to rearrange assigned actions. Actions will be

processed consecutively. Actions lower in the list will be processed last.
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Events

Overview

The Events tab allows you to assign events to the different categories. 

When an event occurs, it is categorized, which in turn triggers the assigned actions.

All possible events are listed here.
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Domain Shows the type of events.

Label Shows the description of each specific event.

Category Can be edited and allows you to assign each event to one of the categories you have

defined.

- Assign an event to a category [or leave the defaults].

- You can also choose None, which means that the event does not trigger a

notification.

- You can select multiple entries in the list to change their category all at once. Select

the entries in the list first.

- Select File > New from the menu if you would like to restore the default settings.

Description Shows an in-depth explanation of the event.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Copy Selected Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Selected Rows

To Clipboard

Copies the currently selected line or lines [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]
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Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: eve:max shows all lines that include events referring to maximums by referencing the column

Event, for example.

Special Events

In order to monitor if the connection to RDM devices/sub-devices/fixtures has been lost, use the following events:

§ DeviceConnectionLost

[Indicating that the connection has been lost.]

§ DeviceConnectionRestored

[Indicating that the connection has been restored successfully.]

§ By default, these events are set to the Critical Category.

In order to monitor if the connection to interfaces has been lost, use the following events:

§ InterfaceConnectionLost

[Indicating that the connection has been lost. The average time it takes before such an event is registered is: 3

minutes.]

§ InterfaceConnectionRestored

[Indicating that the connection has been restored successfully.]

§ By default, these events are set to the Critical Category.
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6.10 History

This topic includes:

§ Introduction

§ Requirements

§ Overview

§ Navigation

§ Context-Menu

§ Visual Data Graphs

Introduction

The History view presents sensor values, sensor value events, and status messages of devices and their sensors

graphically over time.
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Requirements

In order to record data over time and make data progression visible in the History view, several requirements need to

be met:

1] A MADRIX KEY with a valid MADRIX RADAR big data license needs to be connected to the software. 

Learn more »License System 

2] PostgreSQL Server needs to be set up as database management system. 

Learn more »Database 

3] The Store History settings need to be activated in the Options. 

Learn more »Generators 

Overview

From Allows you to define the exact beginning of the time interval that is shown as data

graph.

When navigating in the graphical view, this field will be updated accordingly and

automatically.

To Allows you to define the exact end of the time interval that is shown as data graph.

When navigating in the graphical view, this field will be updated accordingly and

automatically.

Sensor Values Series Shows or hides all recorded sensor values. 

[This includes Present Value Series, Recorded Values Series, Detected

MIN/MAX Series.]

Present Value

Series

Shows or hides all sensor values that were received based on regular RDM

requests sent to the devices. Learn more »Timing
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Recorded Values

Series

Shows or hides all sensor values that were recorded by a device itself. A device

needs to support this feature. Learn more »Sensors

Detected

MIN/MAX Series

Shows or hides all Min/Max Detected sensor values, which are the lowest or

highest values ever recorded for a sensor. A device needs to support this feature.

Sensor Value Events Shows or hides all reported sensor value events. 

[By default, this includes Critical, Validation.]

Critical Shows or hides all critical sensor value events. 

- If this category is shown depends on your settings.

- By default, sensor value events are assigned to the categories Critical or

Validation in the Event Configuration. 

- You can freely rename categories or assign new categories. 

- Learn more »Event Notifications 

Validation Shows or hides all validation sensor value events.

- If this category is shown depends on your settings.

- By default, sensor value events are assigned to the categories Critical or

Validation in the Event Configuration. 

- You can freely rename categories or assign new categories. 

- Learn more »Event Notifications 

Status Messages Shows or hides all recorded status messages of the device. 

[This includes Advisory Hints, Warnings, Errors as defined by the RDM

standard.]

Advisory Hints Shows or hides all advisory status messages.

Warnings Shows or hides all warning status messages.

Errors Shows or hides all error status messages.
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Navigation

You can easily navigate within the data graphs and adjust the view according to your needs.

Left Mouse Click +

Hold + Move

Allows you to move freely along the X-axis and Y-axis.

Mouse Wheel Quickly zooms in and out in order to narrow or enlarge the shown time interval. This

determines the level of detail.

Zooming in or out may group several data points, status messages, or events into one

data point in order to declutter the graph. The tooltip will then include all items

combined.

Ctrl + Mouse Wheel Activates only the horizontal zoom and scales only along the X-axis.

Ctrl + Shift + Mouse

Wheel

Activates only the vertical zoom and scales only along the Y-axis.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Fit Plot To Viewport Automatically defines a sensible scale of the X-axis [time interval] and Y-axis [unit]

according to the recorded data that is currently shown.
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[At least 2 data points need to be visible first.] 

[Keyboard shortcut: Space]

Visual Data Graphs

§ In order to show historical data, you first need to

- Select a single device [in the Devices View].

and

- Select a single sensor of this specific device [in the Sensors View].

§ The following data will then be shown:

- Sensor values of the selected sensor.

- Sensor value events of the selected sensor.

- Status messages of the selected device.

§ Present Values will be shown as blue line [trend line] with blue dots [recorded data points]. 

§ Recorded Values will be shown as gray line [trend line] with gray dots [recorded data points]. 

§ MIN/MAX Values will be shown as black line [trend line] with black dots [recorded data points]. 

- Mouse-Over - Hover with you mouse over such a dot and MADRIX RADAR will show a tooltip that includes

the timestamp as well as the sensor value.

- If a data point includes several sensor values, the average will be calculated for Momentary Values as well as

Recorded Values. The lowest or highest value will be used for Min/Max Values.

- A gradient [red-orange-yellow-green] will be drawn between value minimums and maximum and therefore

include a helpful graphical representation of the current status. Learn more »Sensors

§ Sensor value events will be shown as dashed/dotted, vertical lines:

- In purple.

- Mouse-Over - Hover with you mouse over such a line and MADRIX RADAR will show a tooltip that includes

the timestamp [YYYY/MM/DD  HH:MM:SS] as well as the event.
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§ Status messages will be shown as dashed/dotted, vertical lines:

- Category Advisory is shown in white.

- Category Warning is shown in yellow.

- Category Error is shown in red.

- Mouse-Over - Hover with you mouse over such a line and MADRIX RADAR will show a tooltip that includes

the timestamp [YYYY/MM/DD  HH:MM:SS] as well as the status message.

§ The X-axis represents the timeline with time intervals.

§ The Y-axis represents the unit of the sensor value [such as °C for temperatures].
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6.11 Log

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search

§ Options

§ Customization

Introduction

The Log view shows all important occurrences of the MADRIX RADAR Software itself. 

Such files are very helpful for technical support and assistance, but aren't necessarily required for the general use of

the software. Still, it can provide you with valuable information and feedback for troubleshooting.
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Overview

§ Severity - Allows you to filter only for specific kinds of information [including Info, Warning, Critical,

Fatal]. 

- A specific severity level includes information for its own level as well as all higher levels. 

By default, the following information is provided since the following columns are enabled in the list:

Timestamp Shows the local time when the status message occurred.

[YYYY/MM/DD  HH:MM:SS]

[In contrast, log files are set to UTC time zone.]

Severity Shows the classification for messages.

Module Shows the software module [as information for the developers].

Message Contains the contents and main information of the status message.

A maximum of 10,000 entries can be logged.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.
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Clear Log Messages Removes all logged items from the list.

Show Log File

Directory...

Opens the folder on your computer that holds saved log files. 

[You can change the directory in the options »Logfile]

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all parameter information] into the

clipboard/temporary memory. [Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all parameters in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: mess:IP shows all lines that include IP device information by referencing the column

Message, for example.
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Options

A new log file is created with each software start.

In addition, you can set up further settings for the Log in the Options.

Learn more »Logging 

Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Timestamp Shows or hides the Timestamp column.

Severity Shows or hides the Severity column.
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Module Shows or hides the Module column.

Thread Shows or hides the Thread column.

Message Shows or hides the Message column.

6.12 Patch Editor

This topic includes:

§ Introduction

§ Overview

§ Menu

§ Toolbar

§ Context-Menu And Keyboard Navigation

§ Editing And Changing Values

§ Automatic Workflow

§ Semi-Automatic Workflow

§ Troubleshooting

§ Customization

Introduction

The Patch Editor is an extremely useful tool to quickly address and connect RDM devices [mainly lighting fixtures], that

is setting their DMX start address. It considerably speeds up the configuration and setup times of your lighting project.

§ Go to the menu Devices > Patch Editor...

[Keyboard shortcut: F3]
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Overview

The following is a general overview. The workflows on how to work with this tool are described below.

Represents the device numbering as index and is especially useful for referencing

devices in the list or seeing the total number of found devices. 

Grip Left Mouse Click + Hold + Drag & Drop - Indicates that you can change the

order of devices by dragging & dropping the corresponding lines in the list. The order

determines the addressing order when using the automatic patching process. Learn

more below.

Include

 

Allows you to choose which devices to include in the automatic patching process. Learn

more below.

Devices that report back a DMX foot print of 0, will be automatically excluded. You can

include them manually again.
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Mark  Colorizes the corresponding line of the list in green to label it for easy referencing,

especially in long lists.

Network Shows the network adapter, and its network IP address in particular, to which the RDM

device is connected. [This information refers to »Art-Net.]

Interface IP Address Shows the IP address of the hardware interface to which the RDM device is connected.

[This information refers to »Art-Net.]

Unique ID Represents a unique identifier of the RDM device. It is shown as HEX [without 0x] and

using a colon [:] as separator. The first part is the ESTA ID of the manufacturer and

the second part is a number, which can be freely defined by the manufacturer. 

Sub-Device ID Shows the sub-device ID for RDM devices that have one. For all others, the value is 0. 

Identify Can be edited. Allows you to choose/activate the built-in identification mode of the RDM

device if available from the device. This usually means that the device will fully flash in

white.

Device Label Can be edited. Shows the currently set name or description of the RDM device.

DMX Personality Can be edited. Shows the currently set DMX personality of the RDM device. This can

also be referred to as operation mode of the RDM device.

DMX Foot Print Shows the number of DMX channels a device uses; and as such requires for individual

control. Depends on the currently set DMX personality.

Devices that report back a DMX foot print of 0, will be automatically excluded. You can

include them manually again.

DMX Start Address Can be edited. Shows the currently set DMX start address of the RDM device. [Learn

more »Glossary]
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Status Shows the current status of the patching process regarding this device.

- A green checkmark indicates that the currently set DMX start address is logical and

valid.

- An orange triangle indicates that there is an issue. Refer to the displayed status

message for more information.

Total DMX Footprint Shows how many channels are currently occupied by the devices in the list.

- Amounts of channels that exceed the defined limited of 512 of the DMX standard will

be highlighted in orange.

Last DMX Channel Shows the last occupied channel of the currently selected DMX universe.

- If the channels of the last RDM device exceed the defined limited of 512 of the DMX

standard, the number will be highlighted in orange.

Please note: This list cannot be sorted by clicking on one of the column headers. The order of list

entries defines the order devices are addressed when activating automatic addressing. The order of

items needs to be set completely intentionally by you.
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Menu

File

§ Close - Closes the window of the Patch Editor.

Preferences

§ Address Devices Automatically - Enables and activates the automatic patching process. Learn more

below. Is disabled by default to not re-address devices unintentionally. It will also automatically be deactivated

again after closing the Patch Editor.

[Keyboard shortcut: Ctrl + Shift + R]

§ Identify Selected Devices Automatically -  Automatically sets the Identify parameter to On in case one

or more devices are selected in the list. [The parameter is set to Off for all devices that are not selected; or

upon deselection.]

Devices
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§ Address Devices Continuously (Set:DmxStartAddress) - Recalculates the DMX addresses for all

currently shown RDM devices and sets the new addresses [by sending the corresponding request to the

devices]. 

[Keyboard shortcut: Ctrl + R]

- As such you can trigger the automatic patching process once for the currently shown devices.

§ Identify All Devices (Set:IdentifyDevice) - Sets the Identify parameter to On for all devices.

[Keyboard shortcut: Ctrl + Alt + Shift + F7]

§ Stop Identifying All Devices (Set:IdentifyDevice) - Sets the Identify parameter to Off for all devices.

[Keyboard shortcut: Ctrl + Shift + F7]

Toolbar

Address Devices Automatically - Enables and activates the automatic patching

process. Learn more below. 

- Is disabled by default to not re-address devices unintentionally. 

- It will also automatically be deactivated again after closing the Patch Editor or when

changing the view by selecting a different DMX Universe or a different Interface.

- [Keyboard shortcut: Ctrl + Shift + R]

Identify Selected Devices Automatically -  Automatically sets the Identify

parameter to On in case one or more devices are selected in the list. 

- [The parameter is set to Off for all devices that are not selected; or upon

deselection.]

- is enabled by default.

Address Devices Continuously (Set:DmxStartAddress) - Recalculates the

DMX addresses for all currently shown RDM devices and sets the new addresses [by

sending the corresponding request to the devices]. - As such you can trigger the

automatic patching process once for the currently shown devices.

- [Keyboard shortcut: Ctrl + R]
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Identify All Devices (Set:IdentifyDevice) - Sets the Identify parameter to

On for all devices.

- [Keyboard shortcut: Ctrl + Alt + Shift + F7]

Stop Identifying All Devices (Set:IdentifyDevice) - Sets the Identify

parameter to Off for all devices.

- [Keyboard shortcut: Ctrl + Shift + F7]

First DMX Address For

Automatic Addressing

Defines the first DMX address to use when addressing devices in the automatic

patching process. As such, it defines the DMX start address of the first device in the

list.

- Is only available when having Patch DMX Start Addresses Continuously

enabled.

DMX Universe Defines which DMX universe is currently shown; and as such shows all devices that are

assigned to this universe.

Pay attention to this setting! It has a profound effect on how the Patch Editor

works and how it shows the current status. For example, if Universe is set to 1 and

Interface is set to All, the Patch Editor is likely to display status messages for issues,

which may not be an issue at all. Make sure to switch to a single interface in order to

check or use Previous / Next to check all interfaces and universes one by one.

Interface Shows all interfaces that have RDM devices connected for the currently selected DMX

Universe. As such, it allows you to narrow the list of shown RDM devices to specific

hardware interfaces.

If available, the Interface Short Name is added after the IP address in brackets for

reference.

Pay attention to this setting! It has a profound effect on how the Patch Editor

works and how it shows the current status. For example, if Universe is set to 1 and

Interface is set to All, the Patch Editor is likely to display status messages for issues,

which may not be an issue at all. Make sure to switch to a single interface in order to

check or use Previous / Next to check all interfaces and universes one by one.
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Previous / Next - Provide buttons for quick navigation.

- If All is selected for Interface: Skips through the DMX universes.

- If a specific device is selected for Interface: Skips through the available interfaces

of the currently selected universe first, and then to the next or previous universe,

where it iterates through the interfaces again; before going to the next or previous

universe.

Context-Menu And Keyboard Navigation

§ Right Mouse Click - Perform a click with your right mouse button on an entry.

Edit Allows you to change the entry [if it can be edited]. [Keyboard shortcut: F2]

Identify Devices

(Set:IdentifyDevice)

Sets the Identify parameter to On for all currently selected devices. [Keyboard

shortcut: F7]

Stop Identifying Devices

(Set:IdentifyDevice)

Stops the identification mode for all currently selected devices. [Keyboard

shortcut: Shift + F7]
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Move To The Top Sends the currently selected item to the very top of the list in order to place it

first.

You can easily rearrange the list by using the keyboard. Select a list entry first

and then use the keyboard shortcut: Ctrl + W.

Move Up Moves the currently selected item one place up in the list. 

You can easily rearrange the list by using the keyboard. Select a list entry first

and then use the keyboard shortcut: W.

Move Down Moves the currently selected item one place down in the list. 

You can easily rearrange the list by using the keyboard. Select a list entry first

and then use the keyboard shortcut: S.

Move To The Bottom Sends the currently selected item to the very bottom of the list in order to place

it last.

You can easily rearrange the list by using the keyboard. Select a list entry first

and then use the keyboard shortcut: Ctrl + S.

Editing And Changing Values

It is recommended to set the correct Universe  and Interface  first or use Previous / Next  accordingly [as

described above].

Overview

§ In specific cases, the edit icon [that is, a pen] shows that the respective information/column can be edited by

you.
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Single Edits

§ Left Mouse Click + Hold - Allows you to select a single cell.

§ Left Mouse Double-Click - Perform a double-click with your left mouse button on a value in order to edit it.

§ Keyboard shortcut: F2

§ Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.

You may be presented with different choices for the specific parameter.

You may be able to directly enter numbers or text as input.

Multi-Edits

§ Ctrl + Left Mouse Click or Shift + Left Mouse Click + Select First List Entry + Select Last List

Entry - Allows you to select multiple items in the list.

§ Ctrl + A - Selects all devices in the list.

§ F2 - Activates the edit mode for multiple devices at once. Select multiple devices first.

§ Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.

Valid Values And Limits

The valid values for each parameter are defined by the RDM device and its set of features [such as DMX Personality],

the RDM standard [such as Identify], or a different standard [such as DMX Start Address for DMX512].
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Visual Feedback For Edits

The software will show you if any changes you have made are set successfully or not. This status is shown for a

couple of seconds after each change.

Green - The RDM device reported back that the changes

were successfully set.

Yellow - The request is currently pending.

Red - The RDM device could not successfully set the new

value or the request timed out. Learn more »Missing

Responses From RDM Devices

Automatic Workflow

You can use the Patch Editor to quickly set the DMX addresses for RDM devices [lighting fixtures]. As such, a workflow

could look like described below. 

Please note the available settings as described above as well as the individual characteristics of each project.

1] Set up the First DMX Address For Automatic Addressing.

2] Choose the DMX Universe you wish to work in.

3] Change Interface > All to the first interface.

4] Activate  Address Devices Automatically [via keyboard shortcut, the menu, or the toolbar]. MADRIX

RADAR will automatically address each RDM device according to the order in the list and their equivalent DMX foot

print. 

5] Select each device in the list while having Identify Selected Devices Automatically activated. The

corresponding fixture will light up on the installation.

6] If a fixture is not addressed correctly, use drag & drop in the list to correct the order of devices. MADRIX RADAR

will automatically re-address all subsequent RDM devices.

7] Select a device to set its identify mode to On and double-check the order of devices and their addresses again.
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8]  - Quickly navigate through universes and hardware interfaces using the navigation buttons and

repeat the above steps for each universe/hardware interface.

Semi-Automatic Workflow

You can manually set up the DMX addresses of an RDM device. As such, a workflow could look like described below.

It is recommended to set the correct Universe and Interface first or use Previous / Next accordingly [as

described above].

1] Select a device in the list while having Identify Selected Devices Automatically activated. The

corresponding fixture will light up on the installation.

2] Manually enter the correct DMX Start Address in the corresponding column of the list.

3] Proceed accordingly with the next RDM devices.

4]  - Quickly navigate through universes and hardware interfaces using the navigation buttons and

repeat the above steps for each universe/hardware interface.

Troubleshooting

§ The Patch Editor will only show devices if their display is covered by a valid MADRIX RADAR license. Learn more

»License System 

§ Please note that if a device reports back a DMX foot print of 0, automatic patching will not work in this case.

§ RDM does not support changing the assignment of the DMX universe of a device.
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Customization

MADRIX RADAR allows you to choose which columns are presented in this view. You can decide which columns are

hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Grid Shows or hides the Grid column.

Include Shows or hides the Include column.

Mark Shows or hides the Mark column.

Network Shows or hides the Network column.
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Interface IP Address Shows or hides the Interface IP Address column.

Unique ID Shows or hides the Unique ID column.

Sub-Device ID Shows or hides the Sub-Device ID column.

Identify Shows or hides the Identify column.

Device Label Shows or hides the Device Label column.

DMX Personality Shows or hides the DMX Personality column.

DMX Footprint Shows or hides the DMX Foot Print column.

DMX Start Address Shows or hides the DMX Start Address column.

Status Shows or hides the Status column.

6.13 Snapshots

This topic includes:

§ Introduction

§ Creating A Snapshot

§ Restoring From A Snapshot

§ Troubleshooting



[Part 6] Using The Software [Views]

//202www.madrix.com

MADRIX RADAR 1.2. Help And Manual

Introduction

Snapshots in MADRIX RADAR store all editable parameters of all listed RDM devices in a single file for preservation

and future reference.

In practice, that means for example that a base configuration with correct DMX addresses for all of your lighting

fixtures can be saved [and loaded again in the future] if you needed to change the DMX addresses for testing purposes

in between.

MADRIX RADAR can create snapshots or restore settings for your devices again from a snapshot.

Creating A Snapshot

In order to be able to load a snapshot, you need to create at least one snapshot first.

§ Go to the menu File > Create Snapshot...

[Keyboard shortcut: Ctrl + S]

§ A new window opens.

- Enter a meaningful file name and choose the correct directory to save the file.

- Confirm with Save. Abort via Cancel.

§ A MADRIX RADAR Snapshot is saved as an external file [of the file type *.rsx].



[Part 6] Using The Software [Views]

//203www.madrix.com

MADRIX RADAR 1.2. Help And Manual

§ There is no limit as to how many snapshots can be saved [except the available storage on your harddisk].

§ Snapshots include the settings of all RDM devices that are stored in your database and thus listed in the Devices

view.

§ Only parameters that are supported by your RDM devices will be saved in the snapshot [and later can be

restored].

§ All parameters of RDM devices which can be set, i.e. can be changed or edited, will be saved in a snapshot [Set-

Commands]. This may include parameters, such as:

- All manufacturer-specific parameters

- Identify

- Device Label

- DMX Start Address

- DMX Personality

- Sub-Device Status-Report Threshold

- Factory Defaults

- Language

- Device Hours

- Lamp Hours

- Lamp Strikes

- Lamp State

- Lamp-On Mode

- Power State

- Power Cycles

- Display Invert

- Display Level

- Pan Invert

- Tilt Invert

- Pan Tilt Swap

- Clock

- Self-Test

- Preset Scene Number

- DMX Fail Mode

- DMX Startup Mode

- Dimmer Minimum

- Dimmer Maximum

- Dimmer Curve
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- Dimmer Output Response Time

- Modulation Frequency

- Burn-In

- Lock Pin

- Lock State

- Preset Merge Mode

- Power-On Self-Test

- Block Address

- Identify Mode

Restoring From A Snapshot

You can restore the settings of the RDM devices again by loading a snapshot.

Important

§ Restoring from a snapshot will overwrite the current settings of your RDM devices!

It may be advisable to first create an additional snapshot of the current settings before restoring

from a previous snapshot. Then, you can quickly revert to the current settings again.

§ Go to the menu File > Restore From Snapshot...

[Keyboard shortcut: Ctrl + O]

§ A new window opens.

- You can select parameters which should be restored and deselect parameters which should not be restored.

- Only parameters that are supported by your RDM devices are included, and can thus be selected and restored.

- You can choose from all parameters, entire parameter categories, or specific single parameters.

- Confirm your selection with OK. Abort via Cancel.
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§ When confirmed with OK, the settings of your RDM devices will be changed in the Devices view [Main view]. You

will see visual feedback of those edits as usual.

- Learn more »Devices [Main View] 

Troubleshooting

If you are running into issues, refer to the tips and tricks below.

§ A warning message indicates if restoring from a snapshot was not entirely successful: 'One or more parameters

could not be imported!'.

- One of the reasons could be that certain RDM devices are not available anymore in the database [and thus the

list of devices], but the snapshot includes them and their settings.
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§ Restoring from a snapshot potentially modifies a very large number of RDM devices at the same time.

- The process of restoring from a snapshot may need time to be processed by the software, by the hardware

interfaces, and by the RDM devices themselves. Please allow some time.

§ Since the snapshot feature modifies the settings of your RDM devices, the successful editing of these settings

depends on how well your RDM devices respond to such changes. 

- You may run into issues and unsuccessful restoration if RDM devices are prone to error when changing all or

certain parameters.

§ If you are running into issues, try the following means to prevent or circumvent them:

- Use the latest firmware for your hardware interfaces and for your RDM devices.

- Use the Parameter Selection window to deselect parameters you know to be problematic with regard to your

RDM devices.

- Try again to restore from a snapshot one more time or possibly more.

- Use the visual feedback of edits on the user interface in the Devices view to find possible problems. Learn more

»Devices [Main View] 

- Adjust the communication settings of the software, such as the Transaction Timeout and allow increase the

time from 13 s to 30 s. Learn more »Timing

- Take into consideration the settings of the software, such as how often MADRIX RADAR is set to update the

user interface. Learn more »Timing 

- Take into consideration the settings of the software, such as how often MADRIX RADAR is set to request

updates from RDM devices, updates the database, and shows the current status on the user interface. Learn

more »Generators 

- Pause the monitoring of RDM devices before restoring from a snapshot. Learn more »Menu 

- Learn about the technical limitations and realities of the technologies involved. See »Missing Responses From

RDM Devices

6.14 Troubleshooting

This topic includes:

§ Overview

§ Missing Responses From RDM Devices
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Overview

Refer to the topics below to troubleshoot occurring issues.

Missing Responses From RDM Devices

Due to the underlying technologies, you may be experiencing that an RDM device could not successfully apply a setting

changed by you [i.e., a new value] or that the request timed out.

This is likely due to a missing response, which means that MADRIX RADAR did not receive information back from the

device or that the device did not even receive the initial request in the first place.

There are a number of reasons why a Set-Command might not reach a device or why a response may be missing:

§ Timeouts Of RDM Responders

- In the Options of MADRIX RADAR, a Transaction Timeout is defined. It defines the maximum time in seconds

after which a pending response for an RDM request  is considered missing. See »Timing

- This option reflects the realities of working with RDM. 

- An RDM Responder might receive too many requests, such as Set-Commands and Get-Commands, and might

not be able to respond to all of them. 

- In return, responses are missing.

§ UDP

- MADRIX RADAR uses RDM over Art-Net. This data tunnel is referenced as the ArtRdm subcategory within Art-

Net. Art-Net is a communication protocol using Ethernet networks.

- Art-Net is using UDP, the User-Datagram Protocol. By using the simpler connectionless communication and not

connection-oriented communication, UDP does not include mechanisms to monitor the state of sent packets. 

- The protocol therefore does not include responses if a packet has been received by the recipient. Packets are

simply sent out without maintaining a steady connection between sender and receiver as UDP was not designed

for this.

- As explained above, MADRIX RADAR has implemented its own mechanisms to try to sustain the connection and

assign responses to the corresponding requests. However, after a certain time responses need to be considered

as lost. Otherwise, you would need to wait indefinitely for responses, which defeats the purpose of working with
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RDM devices productively.

- Due to the design of the protocol, responses therefore can be lost.

- One reason can be that there is too much data traffic on the network. [In this case, you can reduce traffic by

temporarily switching off senders and by pausing the monitoring of MADRIX RADAR, for example.]

- Another reason can be that the used network switch does not have enough memory to successfully transmit all

data packets. [More advanced professional networking gear can help meet the actual requirements of the

network and its data traffic.]

§ Processing Timings Of Hardware Interfaces

- Hardware interfaces, such as MADRIX STELLA, need to process the RDM data packets. 

- Thereby, certain timings are used for the communication between RDM Controllers and RDM Responders.

- Managers, such as MADRIX RADAR, in turn may use their own timings to send data to the RDM Controllers. 

- A high number of data packets or aggressive timings can lead to the situation that RDM controllers cannot fully

process incoming packets, since their buffer might not be large enough. Then, older packets might be discarded

since new packets were already received.

Pending Generator Requests

You may find the following messages in the Log view or log files:

§ No parameter requests have been generated in the recent interval of <set generator

interval> due to still pending requests! This may be caused by a temporary peak of other

requests, or inappropriate generator settings.

§ No sensor value requests have been generated in the recent interval of <set generator

interval> due to still pending requests! This may be caused by a temporary peak of other

requests, or inappropriate generator settings.

§ No status message requests have been generated in the recent interval of <set

generator interval> due to still pending requests! This may be caused by a temporary

peak of other requests, or inappropriate generator settings.

This indicates a peak in queued requests referring to a temporarily fully occupied scheduler. If you are seeing such a

message, work through the following steps:

1] How Often Is The Message Appearing?
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§ Rarely - You may only run into this issue due to additionally triggered actions, such as Identify All Devices, or

Discover Devices. In this case, probably no further action is required.

§ Often - You should check the settings under Preferences > Options... > Generators. You may need to

reduce the intervals by increasing the settings.

2] Which Generator Is Mainly Affected?

§ Parameter Request Generator - Too many parameters, sensor values, and/or status messages are being

requested in too small time intervals. You should check the settings under Preferences > Options... >

Generators. You may need to reduce the intervals by increasing the settings of the generators.

§ Sensor-Value Request Generator - Too many sensor values and/or status messages are being requested in

too small time intervals. You should check the settings under Preferences > Options... > Generators.

You may need to reduce the intervals by increasing the settings of the generators.

§ Status-Message Request Generator - Too many status messages are being requested in too small time

intervals. You should check the settings under Preferences > Options... > Generators. You may need to

reduce the intervals by increasing the settings of the generators.

3] Was Changing The Timing Intervals Of The Generators Not Sufficient Or Cannot Be Applied?

§ Sending Frame Time (s) - Check the setting under Preferences > Options... > Timing. You may

need to reduce the setting. But do not set it lower than the Frame Time of the slowest hardware interface in the

installation!

§ How are lighting fixtures distributed among hardware interfaces and DMX universes? You may need

to change the wiring and counterbalance the DMX lines more equally to reduce data traffic on each individual

line.
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7 MADRIX RDM Nodes

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Combined with neat hardware products, the MADRIX system is a proven and innovative LED control solution. MADRIX

hardware reliably transfers the lighting data to your LEDs and controllers. Any small or large LED installation benefits

from prime build quality and outstanding features.

Topics Of This Chapter

Learn more about MADRIX hardware interfaces that support RDM:

§ »MADRIX STELLA 

7.1 MADRIX STELLA

This topic includes:

§ Overview

§ Required Firmware Version

§ Using A 3rd-Party Controller

§ Putting The Device Into Operation

§ LED Status Codes

§ Remote Device Management [RDM]

§ Daisy-Chain Support

§ Reset To Factory Default Settings

§ Device Configuration
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Overview

MADRIX STELLA is a 2-port network node with RDM support for solid-state projects.

The MADRIX STELLA is a dedicated control interface for DMX512 and Art-Net or Streaming ACN that is designed for

high quality and practicability in permanent LED installations.

RDM Role: Transmits commands and requests to RDM Responders and back (Art-Net Node / RDM Controller)

Required Firmware Version

In order to function properly, the following firmware version is at least required for all MADRIX STELLA devices as

minimum version in combination with MADRIX RADAR:
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§ 2.3.7261

It is recommended to always use the latest firmware version.

Using A 3rd-Party Controller

MADRIX STELLA is a standard network node. Because of this, you can use the device with applications, consoles,

desks, or controllers that are compatible with Art-Net or Streaming ACN [sACN] to distribute network data via Ethernet

network.

Putting The Device Into Operation

1] Connecting Your LED Fixtures/DMX Devices

Please see the MADRIX STELLA Technical Manual & Quick Start Guide  on how to connect your LED

fixtures/DMX devices to MADRIX STELLA. 

»help.madrix.com

2] Connecting To Power And Data

Please see the MADRIX STELLA Technical Manual & Quick Start Guide on how to connect to power and

data. 

»help.madrix.com

http://help.madrix.com/
http://help.madrix.com/
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3] Device Settings

Make sure to set the correct network data source and other settings according to the

controller/sender you want to use.

Continue with:

§ Device Configuration 
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LED Status Codes

The following tables describe the LED status codes of the device.

STATUS STATUS LED POWER

Powered off Power not connected. ’ The device has no power.

Permanently green Connected to power. ’ The power is on.

Blinking green Bootloader activated. ’ Reset device / upload firmware.

STATUS STATUS LED USB

Powered off USB not connected.

Red +
blinking green

Communicating over USB.
’ Sending or receiving data over USB. The USB port works.

Fading between
red +green

Connected to USB; Drivers installed correctly.
’ No data is sent over USB.

Orange Connected to USB; No drivers installed.
’ Reinstall software and drivers or try a different USB port.

STATUS STATUS LED DMX 1 STATUS LED DMX 2

Powered off No data is sent. No data is sent.

Blinking green Sending or receiving data.
’ The DMX port works.

Sending or receiving data.
’ The DMX port works.

STATUS STATUS LEDS ETHERNET PORTS

Green off 10 MBit/s connected.

Green on 100 MBit/s connected.

Orange on Network connected.

Orange blinking Sending or receiving data. ’ The Ethernet port works.
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Remote Device Management [RDM]

In order to use it, call up the built-in web configuration [see below] and go to DMX Output Settings > Enable

RDM for ports DMX 1 and/or DMX 2

Make sure to disable RDM on the specific port, when using STELLA for DMX-IN.

Daisy-Chain Support

STELLA features 2 separate Ethernet network ports. Either one is fully functionally for IN and OUT and can be used for

the data connection without using a separate network switch or router. 

[We recommend to connect a maximum of 40 units after one another in a row, when using Art-Net in Unicast Mode or

Streaming ACN Multicast at a max. data rate of 50 FPS / 20 ms without any additional devices in the network.

In the MADRIX 5 Software, we highly recommend to activate ArtSync for excellent image quality.]

Reset To Factory Default Settings

In rare cases, you might need to do a reset to factory default settings, for example to reset to the device to its default

IP address as shown on the side of the device:

Reset Via Reset Button

1] Disconnect all connections from the device [power, data, DMX].

2] Use a suitable tool to press the reset button [between DMX 1 and 2].

3] Continue to press the reset button and supply power again over 'Power' or USB.

4] Continue to press the reset button and wait until all status LEDs of the device flash repeatedly or wait 10

seconds.

[Simply repeat these steps should the process fail.]
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Device Configuration

When connected to Ethernet network, you can easily configure MADRIX STELLA using the built-in web configuration

page.

Both, STELLA and your computer, need to be in the same network.

Using a standard web browser:

§ Connect MADRIX STELLA and your computer to the same network.

§ Assign correct network settings for your PC in the Windows operating system. 

[Recommended default settings: IP address 10.0.0.1 / Subnet mask 255.0.0.0]

[Please note: Your devices and the sender, such as the PC that runs MADRIX RADAR, need to have the same

subnet mask!]

§ Open your web browser and enter the IP address of MADRIX STELLA.

[You can find the default IP address on the back side of the device.]

§ The web configuration page will be launched. Now, you have access to various information and settings.

Configuration Using A Web Browser

When connected to Ethernet network, you can easily configure MADRIX STELLA using the built-in web configuration

page.

You have access to the web interface. Both, STELLA and your computer, need to be in the same network.

Using a standard web browser:

§ Connect MADRIX STELLA and your computer to the same network.

§ Assign correct network settings for your PC in the Windows operating system. 

[Recommended default settings: IP address 10.0.0.1 / Subnet mask 255.0.0.0]

[Please note: Your devices and the sender, such as the PC that runs MADRIX 5, need to have the same subnet

mask!]
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§ Open your web browser and enter the IP address of MADRIX STELLA.

[You can find the default IP address on the back side of the device.]

§ The web configuration page will be launched. Now, you have access to various information and settings.

MADRIX STELLA automatically switches to input when receiving data [DMX-IN]. Since this happens

automatically, there is no need and no option to manually switch from output to input.

Please confirm any changes with Set

Device Name - You can change the description of the device by entering a name. 

Confirm with Set

Network Address You can change the basic network device settings. 

Confirm with Set

§ IP Address

§ Subnet Mask

[Please note: Your devices and the sender, such as the PC that runs MADRIX 5,

need to have the same subnet mask!]

Network To DMX

Output

This section shows the network settings when using the DMX ports for output [DMX 1

and DMX 2].

Confirm with Set

Assigned Network Universe - Defines the universe on which data is sent. 

§ By default, universe 1 and 2 assigned to DMX 1 and DMX 2.

§ If you are broadcasting data for a large number of Universes [using Broadcast

Mode instead of using Unicast Mode] with MADRIX 5 or a 3rd-party controller for

example, you can assign different DMX universes to each STELLA device with

these settings. Each MADRIX STELLA will then only receive data from the specific

Art-Net universe and send it to its specified output port. 

Example: You can set up that STELLA #1 only listens to Art-Net universe 1 and 2,
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while STELLA #2 listens to Art-Net universe 3 and 4, and STELLA #3 listens to

Art-Net universe 5 and 6, and so on.

§ Universes are shown in hexadecimal notation and Art-Net Net switch / sub-net

switch notation in the Network Universe tooltips.

Enable RDM - Allows the device to receive and send Remote Device Management

data on the specific port. 

§ Make sure to disable RDM on the specific port, when using STELLA for DMX-IN.

Device Accepts Network Data From - Defines the data source for the device.

Choose from the following options:

§  Art-Net

§ Streaming ACN

§ Art-Net And sACN

DMX Output

Configuration

This section shows the settings for the DMX ports when used for output [DMX 1 and

DMX 2].

Confirm with Set

Channel Offset - Allows you to shift the received DMX universe [512 DMX

channels] per port if required.

§ This will modify the output.

§ +1 To +511 - Adding a positive channel offset will shift the received channels

to higher channel numbers. 

- Example: Received channel #1 will be shifted to channel #11 by using a channel

offset of 10.

- That means that new channels are added to the data [in front of the received

data block, with DMX value 0], while any channels that now would be higher than

512 will be removed.

- Example, continued: Channels 1 to 10 are newly added, while channels 503 to

512 are removed.
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§ -1 To -511 - Adding a negative channel offset will shift the received channels

to lower channel numbers.

- Example: Received channel #512 will be shifted to channel #412 by using a

channel offset of -100.

- That means that the first channels will be removed. The frame will be shorter.

- Example, continued: Channels 1 to 100 are now removed and the frame has

412 channels in total.

§ Example: Your fixture should start with DMX channel 7.

- In the ideal case, you would set its DMX start address to 7. 

- If your fixture somehow is set to channel 6, you could increase its start address

by +1.

- Or you could shift the data that is sent by your device by -1 in order to change

the data from channel #7 to channel #6.

[If you cannot change the fixture's settings or you cannot reach it anymore, for

example.]

§ Please note: According to the DMX512 standard, a minimum of 21 channels will

always be sent.

§ A Channel Offset can have several advantages, such as splitting a single universe

onto multiple output ports.

- For example, your sender can only send on one universe and you wish to output

it on two ports. 

On DMX 1, you would like to send the first 150 channels and on DMX 2, you

would like to send channels 151 to 300. 

Then, you can set both to the same universe and set a Channel offset of 150 for

DMX 2.

Channel Order - Allows you to change the order of [color] channels for the output. 

§ For example, if you receive channels 1-2-3 [i.e. RGB, for example], the setting 1-

2-3-(4) will send it out as R-G-B. In contrast, the setting 3-2-1 would send B-G-R.

[Please only change this setting when needed and when using simple, standard

fixtures with RGB or RGBW, for example.]
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Send Full Frames - Activates that always 512 channels will be sent out. 

§ 512 channels are sent per frame even if the data that is received by the device

includes less than 512 channels for this port and universe. 

§ The device automatically sends values of 0 on channels that are not used. 

Output Intensity - Sets the brightness level of the output towards the LEDs by

functioning as a dimmer.

§ For example, when the device receives a DMX value of 255 on a channel, this

would be dimmed to 127 when the Output Intensity is set to 50 %.

§ The minimum value is 1 %. The default value is 100 %.

§ Can be used alone or at the same time as Upper Intensity Limit. First, the device

applies the Output Intensity. Second, the Upper Intensity Limit is applied.

Upper Intensity Limit - Sets the maximum brightness level that can be sent. 

§ The minimum value is 1 %. The default value is 100 %.

§ Can be used alone or at the same time as Output Intensity. First, the device

applies the Output Intensity. Second, the Upper Intensity Limit is applied.

In Case Of Missing Network Data - Allows you to specify the output settings

should the device not receive data for a specified DMX universe [in both cases, when

having never received data in the first place or when the data is not being received

anymore and a timeout is reached]. Choose from the following options:

§ Send The Last Received Frame Continually

[If no data is received at startup, black frames will be sent.]

§ Send Black Frames Continually

[If no data is received at startup, black frames will be sent.]

§ Stop Sending After Sending A Black Frame

[If no data is received at startup, black frames will be sent.]

§ Stop Sending

[If no data is received at startup, there is also no output.]
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DMX Input To

Network

This section allows you to specify settings for DMX input, which is sent out to the

network from the device.

Confirm with Set

When data is received, MADRIX STELLA will automatically forward it to Ethernet

network.

The device automatically switches to input when receiving data via the DMX

ports [DMX-IN]. Since this happens automatically, there is no need and no

option to manually switch from output to input.

If both output and input are sent to the device, the device will activate the output.

Send Universe To Network - STELLA can receive 512 channels per port. This

setting defines on which universe those 512 channels are sent.

§ By default, 256 is set for DMX 1 and 255 is set for DMX 2. 

§ Valid values range from 1 to 32768.

Always Send Full Frames To Network - Activates that always 512 channels will

be sent out. 

§ 512 channels are sent per frame even if the data that is received by STELLA

includes less than 512 channels for this port and universe. 

§ STELLA automatically sends values of 0 on channels that are not used. 

§ Art-Net Broadcast Mode - Sends Art-Net data to all IP addresses in the

network.

§ Art-Net Unicast Mode - Sends Art-Net data only to one recipient, e.g. your

MADRIX computer. Enter the IP address of your receiver here.

§ sACN Multicast Mode - Sends Streaming ACN data to IP address

239.255.1.0 for port 1 and to IP address 239.255.0.255 for port 2.
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Special Commands Reboot - Reboot System - Restarts the device completely. [The website will

automatically be reloaded after a few seconds.]

Reset - Reset To Factory Default Settings - Restores the original settings of

the device. [Since this may change back the IP address to the original setting, the

website will automatically be reloaded after a few seconds and you will automatically

be redirected to the correct website and IP address.]

Device Information This section displays various details about the device, including:

§ Model [The device type.]

§ IP Address [The current IP address.]

§ MAC Address [A permanent, unique address.]

§ Serial Number

§ Firmware [The current firmware version.]

§ Bootloader [The current bootloader version.]

§ Hardware [The hardware model.]

§ Voltage [The current voltage for Input.]

§ Temperature [The current ambient temperature.]

§ Ethernet [The current status of the network connection.]
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8 Extra Tools

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

A number of separate tools support the MADRIX RADAR Software.

Topics Of This Chapter

Learn more about separate tools:

§ »MADRIX KEY Firmware Update 

§ »MADRIX RADAR Quick Support 

8.1 MADRIX KEY Firmware Update

This topic includes:

§ Introduction

§ MADRIX KEY Firmware Update
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Introduction

The MADRIX KEY itself is a technologically advanced device. That is why it also comes with its own firmware.

In order to function correctly, the MADRIX RADAR Software requires a minimum firmware version for the MADRIX KEY.

MADRIX KEY Firmware Update

Overview

Make sure that your MADRIX KEY uses the correct firmware. You can update the MADRIX KEY firmware in different

ways.

§ MADRIX RADAR Software Installation

§ Help Menu

MADRIX RADAR Software Installation

During the MADRIX RADAR5 Software setup, you can choose to automatically update all connected USB software

protection dongles.

§ Make sure to select MADRIX KEY Firmware Update

[Deselect it if you don't want to update any connected USB security dongles now.]
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Help Menu

You can also find the link to the MADRIX KEY Firmware Update in the MADRIX RADAR Software:

§ Go to the menu Help > MADRIX KEY > Update MADRIX KEY Firmware... 

8.2 MADRIX RADAR Quick Support

This topic includes:

§ Introduction

§ Instructions

§ Where To Find



[Part 8] Extra Tools

//228www.madrix.com

MADRIX RADAR 1.2. Help And Manual

Introduction

Along with the MADRIX RADAR Software the MADRIX RADAR Quick Support is provided.

Instructions

§ When contacting the MADRIX Support Team, you may be asked by them to use the MADRIX RADAR Quick

Support tool for technical support assistance on your computer.

§ Click on the shortcut in order to launch it [see below where to find it].
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§ After the tool has been launched, wait until Ready to connect (secure connection) is shown.

§ The MADRIX Support Team will then be able to connect to your computer.

§ A new message window opens that reads: 'MADRIX would like to view and control your desktop.

Would you like to allow that?'

Please confirm by clicking Allow

§ The MADRIX Support Team will now be connected.

Where To Find

MADRIX RADAR Quick Support is included in the MADRIX RADAR Installer. After installing MADRIX RADAR, you can find

the link to MADRIX RADAR Quick Support in the Windows Start menu:

§ In Windows 10, go to Start > MADRIX RADAR > MADRIX RADAR Quick Support

The original, executable program can be found in the MADRIX 5 installation directory: 

§ C:\Program Files\MadrixRadar
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9 End-User License Agreement [EULA]

This topic includes:

§ Copy Of License

Copy Of License

END-USER LICENSE AGREEMENT FOR INOAGE SOFTWARE

MADRIX RADAR Software License Agreement

Last Update: 05/2021

This end-user license agreement ('EULA') is a legal agreement between you and the company inoage

GmbH ('inoage'). 

This EULA governs your use of the MADRIX RADAR Software ('software') but not its acquisition, and

thereby does not refer to your purchase contract.

IMPORTANT NOTE

PLEASE CAREFULLY AND THOROUGHLY READ THIS LICENSE AGREEMENT. MAKE SURE THAT YOU FULLY UNDERSTAND

ALL INFORMATION. BY CONTINUING THE INSTALLATION AND/OR BY USING THIS SOFTWARE, YOU CONFIRM THAT

YOU HAVE READ THE LICENSE AGREEMENT, ACCEPT ALL OF ITS TERMS AND CONDITIONS WITHOUT RESERVATIONS,

AND AGREE THAT YOU THUS BECOME LEGALLY BOUND TO THE TERMS OF THIS LICENSE AGREEMENT.

IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS, PLEASE STOP THE INSTALLATION PROCESS. YOU CAN DO

SO BY CLICKING 'CANCEL'. 

IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS BUT HAVE ALREADY INSTALLED THE SOFTWARE, PLEASE

IMMEDIATELY REMOVE, DELETE, AND DESTROY ALL COPIES OF IT AND ASSOCIATED DOCUMENTS AND DATA.

VALIDITY

This license agreement is only valid for the currently used software version as indicated by the

software under the menu 'Help > About... > Version'. This license does not automatically extend

to any software updates that may be available in the future.

WARRANTY DISCLAIMER AND LIMITATION OF LIABILITY

The software or any part thereof is licensed 'as is' and without warranty of any kind.
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inoage does not grant guarantee on validity for a particular reason, the marketability, or other

properties of the product. There is no way to assert a claim to inoage, neither in the legal way

nor in other ways. inoage is not responsible for damages, including all disadvantages that are

not just limited to the loss of sales, but that are caused due to the use of the product, due to

the loss of serviceability of the product, due to misuse, happenings, circumstances, or actions

that inoage does not have influence on, no matter if the damages as well as consequential damages

are direct or indirect, incidental or consequential; whether they are special damages or others,

nor if the damage is caused by the owner of the warranty or a third person.

Any and all such warranties are disclaimed likewise by contributors, licensors, and third parties

of third-party software, SDKs, and drivers that enable specific software features.

You accept that you are using the software at your own and sole risk. This also refers to the

level of satisfaction regarding its quality, features, and performance. 

USAGE RIGHTS

inoage conceded you the limited, non-exclusive right to use this software, and the associated

documents and files, in accordance with the terms of this license agreement. The software is

'used' on a computer or similar hardware system when it has been loaded or installed on a storage

device of the computer, including but not limited to hard disks, SSDs, non-volatile memory, or

similar, or loaded into memory in general. The software usage rights are thus not sold but

conceded under license.

Full ownership over the software and all rights that are not expressly granted to you by this

license remain with inoage.

DEMO MODE

The software can be downloaded for free from the website www.madrix.com and runs in demo mode if

you do not connect a valid and activated MADRIX KEY to your computer or use compatible MADRIX

hardware interface(s), that is valid MADRIX RDM node(s), to unlock the software's features. Demo

mode limits unrestricted usage to the first two RDM devices/sub-devices that are connected. Demo

mode can be used for evaluation, demonstration, testing purposes, and productive use.

SOFTWARE LICENSE AND AUTHORIZED USE

You can purchase a MADRIX KEY that includes a software license after activation or use valid

MADRIX RDM node(s) to unlock the software's features. The MADRIX KEY or MADRIX RDM node(s) can be

used flexibly with different computers if needed, but only unlock the full license once, i.e. at

one computer at a time. A full license can only be unlocked by using a valid MADRIX KEY with a

valid software license or a valid MADRIX RDM node(s).
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You are only authorized to use the software extensively and according to its features within the

limits of the demo mode as described above or when it is fully unlocked by use of a valid MADRIX

KEY with a valid software license or valid MADRIX RDM node(s) especially, but not limited to, for

commercial purposes, production work, and lighting control in live productions or fixed

installations.

RESTRICTIONS

You are not allowed to or allowed to attempt to and agree to not enable others to:

(a) add to, alter, decode, decompile, delete from, disassemble, decrypt, edit, modify, recompile,

rename, reverse-engineer the whole software or any part thereof (except as expressly permitted by

this license regarding open-source components), otherwise attempt to derive or gain access to the

source code, reduce the compiled binary assembly to human-readable form, or create derivative

works from the software or any part thereof;

(b) alter, delete, remove, or obscure any identification of the software, copyright note, or any

other notes relating to the property restrictions of the software or any part thereof;

(c) bypass, circumvent, overcome, or work around any technical or non-technical means,

restrictions, or limitations that are put in place in or together with the software;

(d) copy the whole or parts of the software's documentation.

PERMISSIONS

(a) You are allowed to install, run, and use the software, as long as you have a valid and

activated MADRIX KEY or valid MADRIX RDM node(s) connected to the computer that runs the

software.

(b) As an exception, you may run the software in demo mode for evaluation, demonstration, testing

purposes, and productive use as described above.

TERMINATION

This license is effective until terminated. You can terminate it at any time by removing,

deleting, and destroying all software files and associated copies. This license will also

automatically terminate if you fail to comply with one or more of its clauses. In this case, you

must destroy the software and all the associated data, documents, and copies immediately.

COPYRIGHT AND PROPERTY

This software and all of its source codes are the exclusive property of inoage, except where

otherwise noted, and are protected by the laws in force on the copyright and the intellectual

property. MADRIX is a registered trademark of inoage GmbH. All other company and product names

may be trademarks of their respective companies.
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THIRD PARTIES

Third-party copyright information and legal notices are accessible or point to further

information under the menu 'Help > About...' or corresponding chapters in the software's user

manual.

Certain third-party software, including features provided by the operating system, and/or SDKs

and drivers are required for specific software features. Please note that all of these tools may

be subject to their own, separate end-user license agreements or similar terms and conditions.

CONTACT

You may contact inoage using the following contact details:

inoage GmbH

Wiener Straße 56

01219 Dresden

Germany

Phone: +49 351 862 6869 0

Fax: +49 351 862 6869 68

E-mail: info@madrix.com

Web: https://www.madrix.com

ACCESS

This EULA will also be made directly available as a text file in the default installation

directory of the software.

CONSENT

By clicking 'I Agree', you hereby confirm that you have read, consent to the described policies,

and accepted the license agreement as provided above.
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10 Qt [Legal Information]

This topic includes:

§ Included Libraries

§ Copy Of License

Included Libraries

MADRIX RADAR uses the following libraries of the Qt development framework. 

The libraries and their use are covered by GNU LGPL v.3.

§ Qt5Core.dll

§ Qt5Gui.dll

§ Qt5Network.dll

§ Qt5Sql.dll

§ Qt5Svg.dll

§ Qt5Widgets.dll

§ Qt5Xml.dll

§ qgenericbearer.dll [Qt Plugin DLL] [.../bearer]

§ qsvgicon.dll [Qt Plugin DLL] [.../iconengines]

§ qgif.dll [Qt Plugin DLL] [.../imageformats]

§ qicns.dll [Qt Plugin DLL] [.../imageformats]

§ qico.dll [Qt Plugin DLL] [.../imageformats]

§ qjpeg.dll [Qt Plugin DLL] [.../imageformats]

§ qsvg.dll [Qt Plugin DLL] [.../imageformats]

§ qtga.dll [Qt Plugin DLL] [.../imageformats]

§ qtiff.dll [Qt Plugin DLL] [.../imageformats]

§ qwbmp.dll [Qt Plugin DLL] [.../imageformats]
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§ qwebp.dll [Qt Plugin DLL] [.../imageformats]

§ qdirect2d.dll [Qt Plugin DLL] [.../platforms]

§ qminimal.dll [Qt Plugin DLL] [.../platforms]

§ qoffscreen.dll [Qt Plugin DLL] [.../platforms]

§ qwindows.dll [Qt Plugin DLL] [.../platforms]

§ qsqlite.dll [Qt Plugin DLL]  [.../sqldrivers]

§ qsqlpsql.dll [Qt Plugin DLL] [.../sqldrivers]

The complete, corresponding, and machine-readable source code of these files, including the license text, is available:

§ On the MADRIX Software USB flash drive, in the subfolder ThirdParty. For example, D:\ThirdParty

§ Online at https://www.madrix.com/support/download/

Copy Of License

                   GNU LESSER GENERAL PUBLIC LICENSE

                       Version 3, 29 June 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <https://fsf.org/>

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

  This version of the GNU Lesser General Public License incorporates

the terms and conditions of version 3 of the GNU General Public

License, supplemented by the additional permissions listed below.

  0. Additional Definitions.

  As used herein, "this License" refers to version 3 of the GNU Lesser

General Public License, and the "GNU GPL" refers to version 3 of the GNU

General Public License.
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  "The Library" refers to a covered work governed by this License,

other than an Application or a Combined Work as defined below.

  An "Application" is any work that makes use of an interface provided

by the Library, but which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode

of using an interface provided by the Library.

  A "Combined Work" is a work produced by combining or linking an

Application with the Library.  The particular version of the Library

with which the Combined Work was made is also called the "Linked

Version".

  The "Minimal Corresponding Source" for a Combined Work means the

Corresponding Source for the Combined Work, excluding any source code

for portions of the Combined Work that, considered in isolation, are

based on the Application, and not on the Linked Version.

  The "Corresponding Application Code" for a Combined Work means the

object code and/or source code for the Application, including any data

and utility programs needed for reproducing the Combined Work from the

Application, but excluding the System Libraries of the Combined Work.

  1. Exception to Section 3 of the GNU GPL.

  You may convey a covered work under sections 3 and 4 of this License

without being bound by section 3 of the GNU GPL.

  2. Conveying Modified Versions.

  If you modify a copy of the Library, and, in your modifications, a

facility refers to a function or data to be supplied by an Application

that uses the facility (other than as an argument passed when the

facility is invoked), then you may convey a copy of the modified

version:

   a) under this License, provided that you make a good faith effort to

   ensure that, in the event an Application does not supply the

   function or data, the facility still operates, and performs

   whatever part of its purpose remains meaningful, or

   b) under the GNU GPL, with none of the additional permissions of

   this License applicable to that copy.
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  3. Object Code Incorporating Material from Library Header Files.

  The object code form of an Application may incorporate material from

a header file that is part of the Library.  You may convey such object

code under terms of your choice, provided that, if the incorporated

material is not limited to numerical parameters, data structure

layouts and accessors, or small macros, inline functions and templates

(ten or fewer lines in length), you do both of the following:

   a) Give prominent notice with each copy of the object code that the

   Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the object code with a copy of the GNU GPL and this license

   document.

  4. Combined Works.

  You may convey a Combined Work under terms of your choice that,

taken together, effectively do not restrict modification of the

portions of the Library contained in the Combined Work and reverse

engineering for debugging such modifications, if you also do each of

the following:

   a) Give prominent notice with each copy of the Combined Work that

   the Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the Combined Work with a copy of the GNU GPL and this license

   document.

   c) For a Combined Work that displays copyright notices during

   execution, include the copyright notice for the Library among

   these notices, as well as a reference directing the user to the

   copies of the GNU GPL and this license document.

   d) Do one of the following:

       0) Convey the Minimal Corresponding Source under the terms of this

       License, and the Corresponding Application Code in a form

       suitable for, and under terms that permit, the user to

       recombine or relink the Application with a modified version of
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       the Linked Version to produce a modified Combined Work, in the

       manner specified by section 6 of the GNU GPL for conveying

       Corresponding Source.

       1) Use a suitable shared library mechanism for linking with the

       Library.  A suitable mechanism is one that (a) uses at run time

       a copy of the Library already present on the user's computer

       system, and (b) will operate properly with a modified version

       of the Library that is interface-compatible with the Linked

       Version.

   e) Provide Installation Information, but only if you would otherwise

   be required to provide such information under section 6 of the

   GNU GPL, and only to the extent that such information is

   necessary to install and execute a modified version of the

   Combined Work produced by recombining or relinking the

   Application with a modified version of the Linked Version. (If

   you use option 4d0, the Installation Information must accompany

   the Minimal Corresponding Source and Corresponding Application

   Code. If you use option 4d1, you must provide the Installation

   Information in the manner specified by section 6 of the GNU GPL

   for conveying Corresponding Source.)

  5. Combined Libraries.

  You may place library facilities that are a work based on the

Library side by side in a single library together with other library

facilities that are not Applications and are not covered by this

License, and convey such a combined library under terms of your

choice, if you do both of the following:

   a) Accompany the combined library with a copy of the same work based

   on the Library, uncombined with any other library facilities,

   conveyed under the terms of this License.

   b) Give prominent notice with the combined library that part of it

   is a work based on the Library, and explaining where to find the

   accompanying uncombined form of the same work.

  6. Revised Versions of the GNU Lesser General Public License.

  The Free Software Foundation may publish revised and/or new versions

of the GNU Lesser General Public License from time to time. Such new
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versions will be similar in spirit to the present version, but may

differ in detail to address new problems or concerns.

  Each version is given a distinguishing version number. If the

Library as you received it specifies that a certain numbered version

of the GNU Lesser General Public License "or any later version"

applies to it, you have the option of following the terms and

conditions either of that published version or of any later version

published by the Free Software Foundation. If the Library as you

received it does not specify a version number of the GNU Lesser

General Public License, you may choose any version of the GNU Lesser

General Public License ever published by the Free Software Foundation.

  If the Library as you received it specifies that a proxy can decide

whether future versions of the GNU Lesser General Public License shall

apply, that proxy's public statement of acceptance of any version is

permanent authorization for you to choose that version for the

Library.
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11 Qwt [Legal Information]

This topic includes:

§ Included Libraries

§ Copy Of License

Included Libraries

MADRIX RADAR uses the following libraries. 

The libraries and their use are covered by Qwt License Version 1.0.

§ qwt.dll

The complete, corresponding, and machine-readable source code of these files, including the license text, is available:

§ On the MADRIX Software USB flash drive, in the subfolder ThirdParty. For example, D:\ThirdParty

§ Online at https://www.madrix.com/support/download/

Copy Of License

                             Qwt License

                           Version 1.0, January 1, 2003

The Qwt library and included programs are provided under the terms

of the GNU LESSER GENERAL PUBLIC LICENSE (LGPL) with the following

exceptions:

    1. Widgets that are subclassed from Qwt widgets do not

       constitute a derivative work.

    2. Static linking of applications and widgets to the

       Qwt library does not constitute a derivative work

       and does not require the author to provide source
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       code for the application or widget, use the shared

       Qwt libraries, or link their applications or

       widgets against a user-supplied version of Qwt.

       If you link the application or widget to a modified

       version of Qwt, then the changes to Qwt must be 

       provided under the terms of the LGPL in sections

       1, 2, and 4.

    3. You do not have to provide a copy of the Qwt license

       with programs that are linked to the Qwt library, nor

       do you have to identify the Qwt license in your

       program or documentation as required by section 6

       of the LGPL.

       However, programs must still identify their use of Qwt.

       The following example statement can be included in user

       documentation to satisfy this requirement:

           [program/widget] is based in part on the work of

           the Qwt project (http://qwt.sf.net).

----------------------------------------------------------------------

          GNU LESSER GENERAL PUBLIC LICENSE

               Version 2.1, February 1999

 Copyright (C) 1991, 1999 Free Software Foundation, Inc.

     59 Temple Place, Suite 330, Boston, MA  02111-1307  USA

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL.  It also counts

 as the successor of the GNU Library Public License, version 2, hence

 the version number 2.1.]

                Preamble

  The licenses for most software are designed to take away your

freedom to share and change it.  By contrast, the GNU General Public

Licenses are intended to guarantee your freedom to share and change
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free software--to make sure the software is free for all its users.

  This license, the Lesser General Public License, applies to some

specially designated software packages--typically libraries--of the

Free Software Foundation and other authors who decide to use it.  You

can use it too, but we suggest you first think carefully about whether

this license or the ordinary General Public License is the better

strategy to use in any particular case, based on the explanations below.

  When we speak of free software, we are referring to freedom of use,

not price.  Our General Public Licenses are designed to make sure that

you have the freedom to distribute copies of free software (and charge

for this service if you wish); that you receive source code or can get

it if you want it; that you can change the software and use pieces of

it in new free programs; and that you are informed that you can do

these things.

  To protect your rights, we need to make restrictions that forbid

distributors to deny you these rights or to ask you to surrender these

rights.  These restrictions translate to certain responsibilities for

you if you distribute copies of the library or if you modify it.

  For example, if you distribute copies of the library, whether gratis

or for a fee, you must give the recipients all the rights that we gave

you.  You must make sure that they, too, receive or can get the source

code.  If you link other code with the library, you must provide

complete object files to the recipients, so that they can relink them

with the library after making changes to the library and recompiling

it.  And you must show them these terms so they know their rights.

  We protect your rights with a two-step method: (1) we copyright the

library, and (2) we offer you this license, which gives you legal

permission to copy, distribute and/or modify the library.

  To protect each distributor, we want to make it very clear that

there is no warranty for the free library.  Also, if the library is

modified by someone else and passed on, the recipients should know

that what they have is not the original version, so that the original

author's reputation will not be affected by problems that might be

introduced by others.

  Finally, software patents pose a constant threat to the existence of

any free program.  We wish to make sure that a company cannot
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effectively restrict the users of a free program by obtaining a

restrictive license from a patent holder.  Therefore, we insist that

any patent license obtained for a version of the library must be

consistent with the full freedom of use specified in this license.

  Most GNU software, including some libraries, is covered by the

ordinary GNU General Public License.  This license, the GNU Lesser

General Public License, applies to certain designated libraries, and

is quite different from the ordinary General Public License.  We use

this license for certain libraries in order to permit linking those

libraries into non-free programs.

  When a program is linked with a library, whether statically or using

a shared library, the combination of the two is legally speaking a

combined work, a derivative of the original library.  The ordinary

General Public License therefore permits such linking only if the

entire combination fits its criteria of freedom.  The Lesser General

Public License permits more lax criteria for linking other code with

the library.

  We call this license the "Lesser" General Public License because it

does Less to protect the user's freedom than the ordinary General

Public License.  It also provides other free software developers Less

of an advantage over competing non-free programs.  These disadvantages

are the reason we use the ordinary General Public License for many

libraries.  However, the Lesser license provides advantages in certain

special circumstances.

  For example, on rare occasions, there may be a special need to

encourage the widest possible use of a certain library, so that it becomes

a de-facto standard.  To achieve this, non-free programs must be

allowed to use the library.  A more frequent case is that a free

library does the same job as widely used non-free libraries.  In this

case, there is little to gain by limiting the free library to free

software only, so we use the Lesser General Public License.

  In other cases, permission to use a particular library in non-free

programs enables a greater number of people to use a large body of

free software.  For example, permission to use the GNU C Library in

non-free programs enables many more people to use the whole GNU

operating system, as well as its variant, the GNU/Linux operating

system.
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  Although the Lesser General Public License is Less protective of the

users' freedom, it does ensure that the user of a program that is

linked with the Library has the freedom and the wherewithal to run

that program using a modified version of the Library.

  The precise terms and conditions for copying, distribution and

modification follow.  Pay close attention to the difference between a

"work based on the library" and a "work that uses the library".  The

former contains code derived from the library, whereas the latter must

be combined with the library in order to run.

          GNU LESSER GENERAL PUBLIC LICENSE

   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

  0. This License Agreement applies to any software library or other

program which contains a notice placed by the copyright holder or

other authorized party saying it may be distributed under the terms of

this Lesser General Public License (also called "this License").

Each licensee is addressed as "you".

  A "library" means a collection of software functions and/or data

prepared so as to be conveniently linked with application programs

(which use some of those functions and data) to form executables.

  The "Library", below, refers to any such software library or work

which has been distributed under these terms.  A "work based on the

Library" means either the Library or any derivative work under

copyright law: that is to say, a work containing the Library or a

portion of it, either verbatim or with modifications and/or translated

straightforwardly into another language.  (Hereinafter, translation is

included without limitation in the term "modification".)

  "Source code" for a work means the preferred form of the work for

making modifications to it.  For a library, complete source code means

all the source code for all modules it contains, plus any associated

interface definition files, plus the scripts used to control compilation

and installation of the library.

  Activities other than copying, distribution and modification are not

covered by this License; they are outside its scope.  The act of

running a program using the Library is not restricted, and output from

such a program is covered only if its contents constitute a work based

on the Library (independent of the use of the Library in a tool for
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writing it).  Whether that is true depends on what the Library does

and what the program that uses the Library does.

  1. You may copy and distribute verbatim copies of the Library's

complete source code as you receive it, in any medium, provided that

you conspicuously and appropriately publish on each copy an

appropriate copyright notice and disclaimer of warranty; keep intact

all the notices that refer to this License and to the absence of any

warranty; and distribute a copy of this License along with the

Library.

  You may charge a fee for the physical act of transferring a copy,

and you may at your option offer warranty protection in exchange for a

fee.

  2. You may modify your copy or copies of the Library or any portion

of it, thus forming a work based on the Library, and copy and

distribute such modifications or work under the terms of Section 1

above, provided that you also meet all of these conditions:

    a) The modified work must itself be a software library.

    b) You must cause the files modified to carry prominent notices

    stating that you changed the files and the date of any change.

    c) You must cause the whole of the work to be licensed at no

    charge to all third parties under the terms of this License.

    d) If a facility in the modified Library refers to a function or a

    table of data to be supplied by an application program that uses

    the facility, other than as an argument passed when the facility

    is invoked, then you must make a good faith effort to ensure that,

    in the event an application does not supply such function or

    table, the facility still operates, and performs whatever part of

    its purpose remains meaningful.

    (For example, a function in a library to compute square roots has

    a purpose that is entirely well-defined independent of the

    application.  Therefore, Subsection 2d requires that any

    application-supplied function or table used by this function must

    be optional: if the application does not supply it, the square

    root function must still compute square roots.)
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These requirements apply to the modified work as a whole.  If

identifiable sections of that work are not derived from the Library,

and can be reasonably considered independent and separate works in

themselves, then this License, and its terms, do not apply to those

sections when you distribute them as separate works.  But when you

distribute the same sections as part of a whole which is a work based

on the Library, the distribution of the whole must be on the terms of

this License, whose permissions for other licensees extend to the

entire whole, and thus to each and every part regardless of who wrote

it.

Thus, it is not the intent of this section to claim rights or contest

your rights to work written entirely by you; rather, the intent is to

exercise the right to control the distribution of derivative or

collective works based on the Library.

In addition, mere aggregation of another work not based on the Library

with the Library (or with a work based on the Library) on a volume of

a storage or distribution medium does not bring the other work under

the scope of this License.

  3. You may opt to apply the terms of the ordinary GNU General Public

License instead of this License to a given copy of the Library.  To do

this, you must alter all the notices that refer to this License, so

that they refer to the ordinary GNU General Public License, version 2,

instead of to this License.  (If a newer version than version 2 of the

ordinary GNU General Public License has appeared, then you can specify

that version instead if you wish.)  Do not make any other change in

these notices.

  Once this change is made in a given copy, it is irreversible for

that copy, so the ordinary GNU General Public License applies to all

subsequent copies and derivative works made from that copy.

  This option is useful when you wish to copy part of the code of

the Library into a program that is not a library.

  4. You may copy and distribute the Library (or a portion or

derivative of it, under Section 2) in object code or executable form

under the terms of Sections 1 and 2 above provided that you accompany

it with the complete corresponding machine-readable source code, which

must be distributed under the terms of Sections 1 and 2 above on a

medium customarily used for software interchange.
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  If distribution of object code is made by offering access to copy

from a designated place, then offering equivalent access to copy the

source code from the same place satisfies the requirement to

distribute the source code, even though third parties are not

compelled to copy the source along with the object code.

  5. A program that contains no derivative of any portion of the

Library, but is designed to work with the Library by being compiled or

linked with it, is called a "work that uses the Library".  Such a

work, in isolation, is not a derivative work of the Library, and

therefore falls outside the scope of this License.

  However, linking a "work that uses the Library" with the Library

creates an executable that is a derivative of the Library (because it

contains portions of the Library), rather than a "work that uses the

library".  The executable is therefore covered by this License.

Section 6 states terms for distribution of such executables.

  When a "work that uses the Library" uses material from a header file

that is part of the Library, the object code for the work may be a

derivative work of the Library even though the source code is not.

Whether this is true is especially significant if the work can be

linked without the Library, or if the work is itself a library.  The

threshold for this to be true is not precisely defined by law.

  If such an object file uses only numerical parameters, data

structure layouts and accessors, and small macros and small inline

functions (ten lines or less in length), then the use of the object

file is unrestricted, regardless of whether it is legally a derivative

work.  (Executables containing this object code plus portions of the

Library will still fall under Section 6.)

  Otherwise, if the work is a derivative of the Library, you may

distribute the object code for the work under the terms of Section 6.

Any executables containing that work also fall under Section 6,

whether or not they are linked directly with the Library itself.

  6. As an exception to the Sections above, you may also combine or

link a "work that uses the Library" with the Library to produce a

work containing portions of the Library, and distribute that work

under terms of your choice, provided that the terms permit

modification of the work for the customer's own use and reverse
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engineering for debugging such modifications.

  You must give prominent notice with each copy of the work that the

Library is used in it and that the Library and its use are covered by

this License.  You must supply a copy of this License.  If the work

during execution displays copyright notices, you must include the

copyright notice for the Library among them, as well as a reference

directing the user to the copy of this License.  Also, you must do one

of these things:

    a) Accompany the work with the complete corresponding

    machine-readable source code for the Library including whatever

    changes were used in the work (which must be distributed under

    Sections 1 and 2 above); and, if the work is an executable linked

    with the Library, with the complete machine-readable "work that

    uses the Library", as object code and/or source code, so that the

    user can modify the Library and then relink to produce a modified

    executable containing the modified Library.  (It is understood

    that the user who changes the contents of definitions files in the

    Library will not necessarily be able to recompile the application

    to use the modified definitions.)

    b) Use a suitable shared library mechanism for linking with the

    Library.  A suitable mechanism is one that (1) uses at run time a

    copy of the library already present on the user's computer system,

    rather than copying library functions into the executable, and (2)

    will operate properly with a modified version of the library, if

    the user installs one, as long as the modified version is

    interface-compatible with the version that the work was made with.

    c) Accompany the work with a written offer, valid for at

    least three years, to give the same user the materials

    specified in Subsection 6a, above, for a charge no more

    than the cost of performing this distribution.

    d) If distribution of the work is made by offering access to copy

    from a designated place, offer equivalent access to copy the above

    specified materials from the same place.

    e) Verify that the user has already received a copy of these

    materials or that you have already sent this user a copy.

  For an executable, the required form of the "work that uses the



[Part 11] Qwt [Legal Information]

//252www.madrix.com

MADRIX RADAR 1.2. Help And Manual

Library" must include any data and utility programs needed for

reproducing the executable from it.  However, as a special exception,

the materials to be distributed need not include anything that is

normally distributed (in either source or binary form) with the major

components (compiler, kernel, and so on) of the operating system on

which the executable runs, unless that component itself accompanies

the executable.

  It may happen that this requirement contradicts the license

restrictions of other proprietary libraries that do not normally

accompany the operating system.  Such a contradiction means you cannot

use both them and the Library together in an executable that you

distribute.

  7. You may place library facilities that are a work based on the

Library side-by-side in a single library together with other library

facilities not covered by this License, and distribute such a combined

library, provided that the separate distribution of the work based on

the Library and of the other library facilities is otherwise

permitted, and provided that you do these two things:

    a) Accompany the combined library with a copy of the same work

    based on the Library, uncombined with any other library

    facilities.  This must be distributed under the terms of the

    Sections above.

    b) Give prominent notice with the combined library of the fact

    that part of it is a work based on the Library, and explaining

    where to find the accompanying uncombined form of the same work.

  8. You may not copy, modify, sublicense, link with, or distribute

the Library except as expressly provided under this License.  Any

attempt otherwise to copy, modify, sublicense, link with, or

distribute the Library is void, and will automatically terminate your

rights under this License.  However, parties who have received copies,

or rights, from you under this License will not have their licenses

terminated so long as such parties remain in full compliance.

  9. You are not required to accept this License, since you have not

signed it.  However, nothing else grants you permission to modify or

distribute the Library or its derivative works.  These actions are

prohibited by law if you do not accept this License.  Therefore, by

modifying or distributing the Library (or any work based on the



[Part 11] Qwt [Legal Information]

//253www.madrix.com

MADRIX RADAR 1.2. Help And Manual

Library), you indicate your acceptance of this License to do so, and

all its terms and conditions for copying, distributing or modifying

the Library or works based on it.

  10. Each time you redistribute the Library (or any work based on the

Library), the recipient automatically receives a license from the

original licensor to copy, distribute, link with or modify the Library

subject to these terms and conditions.  You may not impose any further

restrictions on the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with

this License.

  11. If, as a consequence of a court judgment or allegation of patent

infringement or for any other reason (not limited to patent issues),

conditions are imposed on you (whether by court order, agreement or

otherwise) that contradict the conditions of this License, they do not

excuse you from the conditions of this License.  If you cannot

distribute so as to satisfy simultaneously your obligations under this

License and any other pertinent obligations, then as a consequence you

may not distribute the Library at all.  For example, if a patent

license would not permit royalty-free redistribution of the Library by

all those who receive copies directly or indirectly through you, then

the only way you could satisfy both it and this License would be to

refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any

particular circumstance, the balance of the section is intended to apply,

and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any

patents or other property right claims or to contest validity of any

such claims; this section has the sole purpose of protecting the

integrity of the free software distribution system which is

implemented by public license practices.  Many people have made

generous contributions to the wide range of software distributed

through that system in reliance on consistent application of that

system; it is up to the author/donor to decide if he or she is willing

to distribute software through any other system and a licensee cannot

impose that choice.

This section is intended to make thoroughly clear what is believed to

be a consequence of the rest of this License.
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  12. If the distribution and/or use of the Library is restricted in

certain countries either by patents or by copyrighted interfaces, the

original copyright holder who places the Library under this License may add

an explicit geographical distribution limitation excluding those countries,

so that distribution is permitted only in or among countries not thus

excluded.  In such case, this License incorporates the limitation as if

written in the body of this License.

  13. The Free Software Foundation may publish revised and/or new

versions of the Lesser General Public License from time to time.

Such new versions will be similar in spirit to the present version,

but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number.  If the Library

specifies a version number of this License which applies to it and

"any later version", you have the option of following the terms and

conditions either of that version or of any later version published by

the Free Software Foundation.  If the Library does not specify a

license version number, you may choose any version ever published by

the Free Software Foundation.

  14. If you wish to incorporate parts of the Library into other free

programs whose distribution conditions are incompatible with these,

write to the author to ask for permission.  For software which is

copyrighted by the Free Software Foundation, write to the Free

Software Foundation; we sometimes make exceptions for this.  Our

decision will be guided by the two goals of preserving the free status

of all derivatives of our free software and of promoting the sharing

and reuse of software generally.

                NO WARRANTY

  15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR

OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY

KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE

LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME

THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

  16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
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WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY

AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU

FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR

CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE

LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING

RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A

FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF

SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH

DAMAGES.

             END OF TERMS AND CONDITIONS

           How to Apply These Terms to Your New Libraries

  If you develop a new library, and you want it to be of the greatest

possible use to the public, we recommend making it free software that

everyone can redistribute and change.  You can do so by permitting

redistribution under these terms (or, alternatively, under the terms of the

ordinary General Public License).

  To apply these terms, attach the following notices to the library.  It is

safest to attach them to the start of each source file to most effectively

convey the exclusion of warranty; and each file should have at least the

"copyright" line and a pointer to where the full notice is found.

    <one line to give the library's name and a brief idea of what it does.>

    Copyright (C) <year>  <name of author>

    This library is free software; you can redistribute it and/or

    modify it under the terms of the GNU Lesser General Public

    License as published by the Free Software Foundation; either

    version 2.1 of the License, or (at your option) any later version.

    This library is distributed in the hope that it will be useful,

    but WITHOUT ANY WARRANTY; without even the implied warranty of

    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the GNU

    Lesser General Public License for more details.

    You should have received a copy of the GNU Lesser General Public

    License along with this library; if not, write to the Free Software

    Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA  02111-1307  USA

Also add information on how to contact you by electronic and paper mail.
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You should also get your employer (if you work as a programmer) or your

school, if any, to sign a "copyright disclaimer" for the library, if

necessary.  Here is a sample; alter the names:

  Yoyodyne, Inc., hereby disclaims all copyright interest in the

  library `Frob' (a library for tweaking knobs) written by James Random Hacker.

  <signature of Ty Coon>, 1 April 1990

  Ty Coon, President of Vice

That's all there is to it!
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12 Sourcetree [Legal Information]

This topic includes:

§ Overview

Overview

Powered by Atlassian.
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13 Imprint And Copyright

This topic includes:

§ Company And Address

§ Copyright

§ Credits

§ Third Parties

Company And Address

inoage GmbH

Wiener Straße 56

01219 Dresden

Germany

Managing Directors: Christian Hertel, Sebastian Pinzer, Sebastian Wissmann

Phone: +49 351 862 6869 0

Fax: +49 351 862 6869 68

Web: www.madrix.com

E-mail: info@madrix.com

Copyright

© Copyright (C) 2001 – 2022 inoage GmbH. All rights reserved.

http://www.madrix.com
mailto:info@madrix.com
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MADRIX® is a registered trademark of inoage GmbH. 

All other company names and/or product names are trademarks and/or entered trademarks of their respective

holders. The product might not always be conforming to the presentation, features, and performances. Technical data

can differ slightly, depending on the operating system and the chosen hardware. 

We withhold the option of changes without notification. inoage GmbH does not give any guaranty for function capability

for a certain purpose, the marked ability or other features of the product. No other guaranty claims, on legal or other

terms, can be enforced. 

Under no circumstances does inoage GmbH take on the responsibility for liabilities for faults for losses in sales volume

or profits, that occur through the usage of the product, through the serviceability, through abuse, happenings,

circumstances or actions, that we have no influence on. No matter if the damages were caused by the holder of the

product or a third person.

Credits

§ Microsoft, Windows are U.S. registered trademarks of Microsoft Corporation.

§ Art-Net™ - Designed by and Copyright Artistic Licence Holdings Ltd.

§ Intel, the Intel logo are trademarks of Intel Corporation or its subsidiaries in the U.S. and/or other countries.

§ NVIDIA is a trademark and/or registered trademark of NVIDIA Corporation in the U.S. and/or other countries.

§ Other product and company names, terms, or [trade] marks are the property of their respective holders.

Third Parties

Qt

See Qt [Legal Information]
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Qwt

See Qwt [Legal Information]

Sourcetree

Powered by Atlassian.
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